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Preface

This guide describes Device Fault Manager (DFM), provides instructions for 
installing DFM on a Windows system, and offers quick-start steps on the use of 
DFM. This guide applies to the following versions of DFM:

• DFM 1.2

• DFM 1.2 Updated for Common Services Version 2.2

Most installation and setup instructions are the same for both versions. Where 
there are differences, it is noted in the documentation.

Audience
This guide is intended for anyone who installs and initially uses DFM.

Conventions
This document uses the following conventions:

Item Convention

Commands and keywords boldface font

Variables for which you supply values italic font

Displayed session and system information screen font
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Product Documentation
Note Means reader take note. Notes contain helpful suggestions or references to 
material not covered in the publication.

Caution Means reader be careful. In this situation, you might do something that could 
result in equipment damage or loss of data.

Product Documentation

Note Although every effort has been made to validate the accuracy of the information 
in the printed and electronic documentation, you should also review the DFM 
documentation on Cisco.com for any updates.

The following product documentation is available:

Release Notes for Device Fault Manager 1.2 Updated for Common Services Version 
2.2 on Windows

This document describes new features in this release of DFM, and any known 
problems and their resolution on a Windows system. This document is available 
in the following formats:

• Hardcopy packaged with the DFM CD-ROM

• On Cisco.com at 
http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/cw2000/dfm/df
m123cd/rel_note/win_rn.htm

Information you enter boldface screen font

Variables you enter italic screen font

Menu items and button names boldface font

Selecting a menu item Option > Network Preferences

Item Convention
x
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Product Documentation
Release Notes for Device Fault Manager 1.2 Updated for Common Services 
Version 2.2 on Solaris

This document describes new features in this release of DFM, and any known 
problems and their resolutions on a Solaris system. This document is available in 
the following formats:

• Hardcopy packaged with the DFM CD-ROM

• On Cisco.com at 
http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/cw2000/dfm/df
m123cd/rel_note/sol_rn.htm

Quick Start Guide for LAN Management Solution

This document, and the Maintenance Kit version of the document, describes the 
basic requirements and procedures for installing, upgrading, and setting up the 
LAN Management Solution. This document is available in the following formats:

• Hardcopy packaged with the DFM CD-ROM

• On Cisco.com at 
http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/cw2000/cw2000
_b/lms/lmsmar03/index.htm

Installation and Setup Guide for Device Fault Manager on Windows

This document describes how to install DFM on a Windows system and offers 
quick-start steps for using DFM. This document is available in the following 
formats:

• PDF on the DFM CD-ROM 

• On Cisco.com at 
http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/cw2000/dfm/df
m123cd/install/windows/index.htm

• Printed documentation available by order
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Product Documentation
Installation and Setup Guide for Device Fault Manager on Solaris

This document describes how to install DFM on a Solaris system and offers 
quick-start steps for using DFM. This document is available in the following 
formats:

• PDF on the DFM CD-ROM

• On Cisco.com at 
http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/cw2000/dfm/df
m123cd/install/solaris/index.htm

• Printed documentation available by order

User Guide for Device Fault Manager

This document describes DFM; provides instructions for configuring, 
administering, and operating it; and answers DFM frequently asked questions. 
This document is available in the following formats:

• PDF on the DFM CD-ROM and from the DFM online help

• On Cisco.com at 
http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/cw2000/dfm/df
m123cd/u_gd/index.htm

• Printed documentation available by order

Context-Sensitive Online Help

You can access the help in two ways:

• Select an option from the navigation tree, then click Help.

• Click the Help button in the dialog box.
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Additional Information Online
The following additional information is available online:

Device Fault Manager Frequently Asked Questions

This document describes DFM frequently asked questions. This document is 
available on Cisco.com at 
http://www.cisco.com/en/US/products/sw/cscowork/ps2421/prod_troubleshooti
ng_guides_list.html.

Fault History 1.1.1 Drop-in Readme for Solaris

This document describes how to download and configure Fault History on Solaris. 
This document is available on Cisco.com at 
http://www.cisco.com/cgi-bin/tablebuild.pl/cw-fault-history.

Fault History 1.1.1 Drop-in Readme for Windows 

This document describes how to download and configure Fault History on 
Windows. This document is available on Cisco.com at 
http://www.cisco.com/cgi-bin/tablebuild.pl/cw-fault-history.

Device adapter packages for all supported devices are installed when you install 
DFM. Information about devices installed with DFM can be found at
http://www.cisco.com/en/US/products/sw/cscowork/ps2421/products_device_su
pport_tables_list.html.

You can download device packages for new devices from Cisco.com and find 
information about all supported devices by logging into Cisco.com at
http://www.cisco.com/cgi-bin/tablebuild.pl/cw2000-dfm.

Device packages are released cumulatively; that is, new device packages contain 
the contents of any previous packages.

To determine which packages are installed on your CiscoWorks Server, select 
Server Configuration > About the Server > Applications and Versions.

You can also obtain any published patches from the download site.
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Obtaining Documentation
Obtaining Documentation
Cisco provides several ways to obtain documentation, technical assistance, and 
other technical resources. These sections explain how to obtain technical 
information from Cisco Systems.

Cisco.com
You can access the most current Cisco documentation on the World Wide Web at 
this URL:

http://www.cisco.com/univercd/home/home.htm

You can access the Cisco website at this URL:

http://www.cisco.com

International Cisco web sites can be accessed from this URL:

http://www.cisco.com/public/countries_languages.shtml

Documentation CD-ROM
Cisco documentation and additional literature are available in a Cisco 
Documentation CD-ROM package, which may have shipped with your product. 
The Documentation CD-ROM is updated monthly and may be more current than 
printed documentation. The CD-ROM package is available as a single unit or 
through an annual subscription.

Registered Cisco.com users can order the Documentation CD-ROM (product 
number DOC-CONDOCCD=) through the online Subscription Store:

http://www.cisco.com/go/subscription
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Obtaining Documentation
Ordering Documentation
You can find instructions for ordering documentation at this URL:

http://www.cisco.com/univercd/cc/td/doc/es_inpck/pdi.htm

You can order Cisco documentation in these ways:

• Registered Cisco.com users (Cisco direct customers) can order Cisco product 
documentation from the Networking Products MarketPlace:

http://www.cisco.com/en/US/partner/ordering/index.shtml

• Registered Cisco.com users can order the Documentation CD-ROM 
(Customer Order Number DOC-CONDOCCD=) through the online 
Subscription Store:

http://www.cisco.com/go/subscription

• Nonregistered Cisco.com users can order documentation through a local 
account representative by calling Cisco Systems Corporate Headquarters 
(California, U.S.A.) at 408 526-7208 or, elsewhere in North America, by 
calling 800 553-NETS (6387). 

Documentation Feedback
You can submit comments electronically on Cisco.com. On the Cisco 
Documentation home page, click Feedback at the top of the page.

You can email your comments to bug-doc@cisco.com.

You can submit your comments by mail by using the response card behind the 
front cover of your document or by writing to the following address:

Cisco Systems
Attn: Customer Document Ordering
170 West Tasman Drive
San Jose, CA 95134-9883

We appreciate your comments.
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Obtaining Technical Assistance
Cisco provides Cisco.com, which includes the Cisco Technical Assistance Center 
(TAC) Website, as a starting point for all technical assistance. Customers and 
partners can obtain online documentation, troubleshooting tips, and sample 
configurations from the Cisco TAC website. Cisco.com registered users have 
complete access to the technical support resources on the Cisco TAC website, 
including TAC tools and utilities. 

Cisco.com
Cisco.com offers a suite of interactive, networked services that let you access 
Cisco information, networking solutions, services, programs, and resources at any 
time, from anywhere in the world. 

Cisco.com provides a broad range of features and services to help you with these 
tasks:

• Streamline business processes and improve productivity 

• Resolve technical issues with online support

• Download and test software packages

• Order Cisco learning materials and merchandise

• Register for online skill assessment, training, and certification programs

To obtain customized information and service, you can self-register on Cisco.com 
at this URL:

http://www.cisco.com

Technical Assistance Center
The Cisco TAC is available to all customers who need technical assistance with 
a Cisco product, technology, or solution. Two levels of support are available: the 
Cisco TAC website and the Cisco TAC Escalation Center. The avenue of support 
that you choose depends on the priority of the problem and the conditions stated 
in service contracts, when applicable.
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Obtaining Technical Assistance
We categorize Cisco TAC inquiries according to urgency:

• Priority level 4 (P4)—You need information or assistance concerning Cisco 
product capabilities, product installation, or basic product configuration.

• Priority level 3 (P3)—Your network performance is degraded. Network 
functionality is noticeably impaired, but most business operations continue.

• Priority level 2 (P2)—Your production network is severely degraded, 
affecting significant aspects of business operations. No workaround is 
available.

• Priority level 1 (P1)—Your production network is down, and a critical impact 
to business operations will occur if service is not restored quickly. No 
workaround is available.

Cisco TAC Website

You can use the Cisco TAC website to resolve P3 and P4 issues yourself, saving 
both cost and time. The site provides around-the-clock access to online tools, 
knowledge bases, and software. To access the Cisco TAC website, go to this 
URL:

http://www.cisco.com/tac

All customers, partners, and resellers who have a valid Cisco service contract 
have complete access to the technical support resources on the Cisco TAC 
website. Some services on the Cisco TAC website require a Cisco.com login ID 
and password. If you have a valid service contract but do not have a login ID or 
password, go to this URL to register:

http://tools.cisco.com/RPF/register/register.do

If you are a Cisco.com registered user, and you cannot resolve your technical 
issues by using the Cisco TAC website, you can open a case online at this URL:

http://www.cisco.com/en/US/support/index.html

If you have Internet access, we recommend that you open P3 and P4 cases through 
the Cisco TAC website so that you can describe the situation in your own words 
and attach any necessary files.
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Cisco TAC Escalation Center

The Cisco TAC Escalation Center addresses priority level 1 or priority level 2 
issues. These classifications are assigned when severe network degradation 
significantly impacts business operations. When you contact the TAC Escalation 
Center with a P1 or P2 problem, a Cisco TAC engineer automatically opens a 
case.

To obtain a directory of toll-free Cisco TAC telephone numbers for your country, 
go to this URL:

http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml

Before calling, please check with your network operations center to determine the 
level of Cisco support services to which your company is entitled: for example, 
SMARTnet, SMARTnet Onsite, or Network Supported Accounts (NSA). When 
you call the center, please have available your service agreement number and your 
product serial number.

Obtaining Additional Publications and Information
Information about Cisco products, technologies, and network solutions is 
available from various online and printed sources.

• The Cisco Product Catalog describes the networking products offered by 
Cisco Systems as well as ordering and customer support services. Access the 
Cisco Product Catalog at this URL:

http://www.cisco.com/en/US/products/products_catalog_links_launch.html

• Cisco Press publishes a wide range of networking publications. Cisco 
suggests these titles for new and experienced users: Internetworking Terms 
and Acronyms Dictionary, Internetworking Technology Handbook, 
Internetworking Troubleshooting Guide, and the Internetworking Design 
Guide. For current Cisco Press titles and other information, go to Cisco Press 
online at this URL:

http://www.ciscopress.com

• Packet magazine is the Cisco monthly periodical that provides industry 
professionals with the latest information about the field of networking. You 
can access Packet magazine at this URL:
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http://www.cisco.com/en/US/about/ac123/ac114/about_cisco_packet_maga
zine.html

• iQ Magazine is the Cisco monthly periodical that provides business leaders 
and decision makers with the latest information about the networking 
industry. You can access iQ Magazine at this URL:

http://business.cisco.com/prod/tree.taf%3fasset_id=44699&public_view=tru
e&kbns=1.html

• Internet Protocol Journal is a quarterly journal published by Cisco Systems 
for engineering professionals involved in the design, development, and 
operation of public and private internets and intranets. You can access the 
Internet Protocol Journal at this URL:

http://www.cisco.com/en/US/about/ac123/ac147/about_cisco_the_internet_
protocol_journal.html

• Training—Cisco offers world-class networking training, with current 
offerings in network training listed at this URL:

http://www.cisco.com/en/US/learning/le31/learning_recommended_training
_list.html
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C H A P T E R 1

Prerequisites

This chapter describes the prerequisites for installing Device Fault Manager 
(DFM) on a Windows system. It includes:

• Product Overview, page 1-2

• Installation and Upgrade Roadmaps, page 1-3

• Installation Paths, page 1-13

• Server Requirements and Recommendations, page 1-14

• Client Requirements, page 1-19

• Supported NMS Environments for Device Import, page 1-21

• Supported NMS Integration, page 1-21

• Supported Devices, page 1-22
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Product Overview
Product Overview
Device Fault Manager is a network management and analytical tool that enables 
you to monitor your network devices and determine the cause of device problems. 
It consists of both internal components and a graphical user interface (GUI).

Table 1-1 describes which DFM components are installed when you select one of 
the installation options.

Table 1-1 DFM Installation Options and Their Contents

Installation Option Installation Option Contents

CiscoWorks 
Device Fault Manager

DFM; the base package for DFM incremental device support (which 
enables you to download support for new devices from Cisco.com); 
the RME Adapter for synchronizing DFM with a local version of 
Resource Manager Essentials (Essentials); and the HPOV-NetView 
Adapter for integrating DFM with local versions of HP OpenView 
and NetView. This option is normally chosen to install the entire 
DFM product on a local machine.

Device Fault Manager 
Incremental Device Support

Only the base package for DFM incremental device support, which 
enables you to download support for new devices from Cisco.com. 
This option is normally chosen to reinstall Incremental DeviceUpdate 
(IDU).

Device Fault Manager 
HPOV-NetView Adapter

Only the HPOV-NetView Adapter. (This option is only displayed if 
HP OpenView or NetView are installed.) This option is normally 
chosen to install the adapter on a remote machine running 
HP OpenView or NetView, to forward traps from these remote 
network management systems (NMSs) to a local DFM. For 
information on how to configure and start this adapter, refer to 
Table 2-4 on page 2-40. You can also install remote adapters using 
DFM 1.2 Patch/IDU 1.2.7 or later.

Device Fault Manager 
RME Adapter

Only the RME Adapter. (This option is only displayed if Essentials is 
installed.) This option is normally chosen to install the adapter on a 
remote machine running Resource Manager Essentials (RME), to 
send a list of devices in the remote Essentials inventory to a local 
DFM. For information on how to configure and start this adapter, 
refer to Table 2-4 on page 2-40. You can also install remote adapters 
using DFM 1.2 Patch/IDU 1.2.7 or later.
1-2
Installation and Setup Guide for Device Fault Manager on Windows

78-14965-01



 

Chapter 1      Prerequisites
Installation and Upgrade Roadmaps
Installation and Upgrade Roadmaps
This section contains installation and upgrade roadmaps for the following 
scenarios:

• Roadmap for a New DFM Installation, page 1-3

• Roadmap for Upgrading to DFM 1.2, page 1-5

• Roadmap for Upgrading to DFM 1.2 Updated for Common Services 
Version 2.2, page 1-8

Roadmap for a New DFM Installation
Table 1-2 provides an overview of how to perform a new DFM installation.

Table 1-2 DFM Installation Roadmap

If you want to 
use... And... You must...

For instructions,
refer to...

DFM as a 
standalone

N/A Install DFM Performing a New 
Installation, page 2-2

DFM with 
Resource 
Manager 
Essentials

Essentials is installed on the DFM 
host

Install DFM (the 
RME Adapter will be 
installed)

Performing a New 
Installation, page 2-2

Essentials is not installed on the 
DFM host

Install RME Adapter 
on the remote 
Essentials host

Installing or 
Upgrading the RME 
Adapter on a Remote 
Host, page 2-46
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DFM with 
HP OpenView or 
NetView

HP OpenView or NetView is 
installed on the DFM host

Install DFM (the 
HPOV-NetView 
Adapter will be 
installed on the same 
drive as NetView)

Performing a New 
Installation, page 2-2

HP OpenView 
or NetView is 
not installed on 
the DFM host

and CiscoWorks 
is installed on the 
HP OpenView or 
NetView host

Install 
HPOV-NetView 
Adapter on the same 
drive as NetView on 
the remote 
HP OpenView or 
NetView host

Installing or 
Upgrading the 
HPOV-NetView 
Adapter on a Remote 
Host Running 
CiscoWorks, 
page 2-42

and CiscoWorks 
is not installed on 
the 
HP OpenView or 
NetView host

Install 
HPOV-NetView 
Adapter on the remote 
HP OpenView or 
NetView host

Installing or 
Upgrading the 
HPOV-NetView 
Adapter on a Remote 
Host Not Running 
CiscoWorks, 
page 2-44

DFM with 
another NMS

You want DFM to both receive 
traps from and forward traps 
(including correlation traps) to the 
NMS

1. Install Device 
Fault Manager

Performing a New 
Installation, page 2-2

2. Enable devices to 
send traps to 
DFM

Enabling Devices to 
Send Traps to DFM, 
page 3-2

3. Enable DFM to 
send traps to 
NMSs

Enabling DFM to 
Send Traps to NMSs, 
page 3-2

Table 1-2 DFM Installation Roadmap (continued)

If you want to 
use... And... You must...

For instructions,
refer to...
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Roadmap for Upgrading to DFM 1.2
Table 1-3 provides an overview of how to upgrade to DFM 1.2.

Note If you are upgrading to DFM 1.2 Updated for Common Services Version 2.2, 
refer to “Roadmap for Upgrading to DFM 1.2 Updated for Common Services 
Version 2.2” section on page 1-8.

Table 1-3 DFM 1.2 Upgrade Roadmap

If you want to 
upgrade to... And... You must... For instructions, refer to...

DFM 1.2 as a 
standalone

DFM 1.1 (with or 
without any 
DFM 1.1 IDSs) is 
installed

1. Install CD One, 
5th Edition

Installation and Setup Guide for 
CD One on Windows 

2. Upgrade to DFM 1.2 Upgrading DFM 1.1 to 
DFM 1.2, page 2-12

DFM 1.2 DFM 1.1 (with or 
without any 
DFM 1.1 IDSs) is 
installed, along 
with other 
applications

1. Determine if all 
installed applications 
are supported by 
CD One, 5th Edition, 
and upgrade them, if 
required

Appropriate documentation

2. Install CD One, 
5th Edition

Installation and Setup Guide for 
CD One on Windows

3. Upgrade to DFM 1.2 Upgrading DFM 1.1 to 
DFM 1.2, page 2-12

4. Upgrade any remote 
adapters to DFM 1.2

Installing and Upgrading 
Adapters, page 2-38
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DFM 1.2 You also want to 
upgrade your local 
operating system 

1. Upgrade your local 
operating system and 
install any required 
patches

Your vendor documentation

2. Determine if all 
installed local 
applications are 
supported by 
CD One, 5th Edition, 
and upgrade them, if 
required

Appropriate documentation

3. Install CD One, 
5th Edition locally

Installation and Setup Guide for 
CD One on Windows

4. Upgrade to DFM 1.2 Upgrading DFM 1.1 to 
DFM 1.2, page 2-12

5. Upgrade any remote 
adapters to DFM 1.2

Installing and Upgrading 
Adapters, page 2-38

Table 1-3 DFM 1.2 Upgrade Roadmap (continued)

If you want to 
upgrade to... And... You must... For instructions, refer to...
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DFM 1.2 You also want to 
upgrade your 
remote operating 
system from a local 
operating system 
that has not been 
upgraded

1. Upgrade your remote 
operating system and 
instal any required 
patches

Your vendor documentation

2. Determine if all 
installed remote 
applications are 
supported by 
CD One, 5th Edition, 
and upgrade them if 
required

Appropriate Documentation

3. Install CD One, 
5th Edition remotely

Installation and Setup Guide for 
CD One on Windows

4. Export local CD One, 
4th Edition 
information to the 
upgraded CD One, 
5th Edition remote 
host

Installation and Setup Guide for 
CD One on Windows

5. Install DFM 1.2 
remotely

Performing a New Installation of 
DFM 1.2, page 2-2

6. Export DFM 1.1 
information to the 
upgraded DFM 1.2 
remote host

Exporting Local DFM 
Information to an Upgraded 
Remote DFM Host, page 2-24

Table 1-3 DFM 1.2 Upgrade Roadmap (continued)

If you want to 
upgrade to... And... You must... For instructions, refer to...
1-7
Installation and Setup Guide for Device Fault Manager on Windows

78-14965-01



 

Chapter 1      Prerequisites
Installation and Upgrade Roadmaps
Roadmap for Upgrading to DFM 1.2 Updated for Common 
Services Version 2.2

Table 1-4 provides an overview of how to perform an upgrade to DFM 1.2 
Updated for Common Services Version 2.2.

Table 1-4 DFM 1.2 Updated for Common Services Version 2.2 Upgrade Roadmap

If you want to 
upgrade to... And... You must... For instructions, refer to...

DFM 1.2 
Updated for 
Common 
Services 
Version 2.2 as a 
standalone

DFM 1.1 (with or 
without any 
DFM 1.1 IDSs) is 
installed

1. Install CD One, 
5th Edition or 
Common Services 2.2

Installation and Setup Guide for 
CD One on Windows or
Installation and Setup Guide for 
CiscoWorks Common Services 
(Includes CiscoView) on 
Windows

2. Upgrade to DFM 1.2 
Updated for Common 
Services Version 2.2 

Upgrading DFM 1.1 to DFM 1.2 
Updated for Common Services 
Version 2.2, page 2-20
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DFM 1.2 
Updated for 
Common 
Services 
Version 2.2

DFM 1.1 (with or 
without any 
DFM 1.1 IDSs) is 
installed, along 
with other 
applications

1. Determine if all 
installed applications 
are supported by 
CD One, 5th Edition 
or Common 
Services 2.2, and 
upgrade them, if 
required

Appropriate documentation

2. Install CD One, 
5th Edition or 
Common Services 2.2

Installation and Setup Guide for 
CD One on Windows or 
Installation and Setup Guide for 
CiscoWorks Common Services 
(Includes CiscoView) on 
Windows

3. Upgrade to DFM 1.2 
Updated for Common 
Services Version 2.2

Upgrading DFM 1.1 to DFM 1.2 
Updated for Common Services 
Version 2.2, page 2-20

4. Upgrade any remote 
adapters to DFM 1.2 
Updated for Common 
Services Version 2.2

Installing and Upgrading 
Adapters, page 2-38

DFM 1.2 
Updated for 
Common 
Services 
Version 2.2 as a 
standalone

DFM 1.2 (with or 
without IDU 1.2.1 
or Patch 1.2.2) is 
installed1,2

1. If desired, install 
Common Services 2.2

Installation and Setup Guide for 
CiscoWorks Common Services 
(Includes CiscoView) on 
Windows

2. Upgrade to DFM 1.2 
Updated for Common 
Services Version 2.2

Upgrading DFM 1.2 to DFM 1.2 
Updated for Common Services 
Version 2.2, page 2-23

Table 1-4 DFM 1.2 Updated for Common Services Version 2.2 Upgrade Roadmap (continued)

If you want to 
upgrade to... And... You must... For instructions, refer to...
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DFM 1.2 
Updated for 
Common 
Services 
Version 2.2

DFM 1.2 (with or 
without IDU 1.2.1 
or Patch 1.2.2) is 
installed, along 
with other 
applications1,2

1. Determine if all 
installed applications 
are supported by 
Common 
Services 2.2, and 
upgrade them, if 
required

Appropriate documentation

2. If desired, install 
Common Services 2.2

Installation and Setup Guide for 
CiscoWorks Common Services 
(Includes CiscoView) on 
Windows

3. Upgrade to DFM 1.2 
Updated for Common 
Services Version 2.2

Upgrading DFM 1.2 to DFM 1.2 
Updated for Common Services 
Version 2.2, page 2-23

Table 1-4 DFM 1.2 Updated for Common Services Version 2.2 Upgrade Roadmap (continued)

If you want to 
upgrade to... And... You must... For instructions, refer to...
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DFM 1.2 
Updated for 
Common 
Services 
Version 2.2

You also want to 
upgrade your local 
operating system1,2

1. Upgrade your local 
operating system and 
install any required 
patches

Your vendor documentation

2. Determine if all 
installed local 
applications are 
supported by 
CD One, 5th Edition 
or Common 
Services 2.2, and 
upgrade them, if 
required

Appropriate documentation

3. Install CD One, 
5th Edition or 
Common Services 2.2 
locally

Installation and Setup Guide for 
CD One on Windows or 
Installation and Setup Guide for 
CiscoWorks Common Services 
(Includes CiscoView) on 
Windows

4. Install DFM 1.2 
Updated for Common 
Services Version 2.2 

Upgrading DFM 1.1 to DFM 1.2 
Updated for Common Services 
Version 2.2, page 2-20 or 
Upgrading DFM 1.2 to DFM 1.2 
Updated for Common Services 
Version 2.2, page 2-23

5. If you are upgrading 
from DFM 1.1, 
upgrade any remote 
adapters to DFM 1.2 
Updated for Common 
Services Version 2.2

Installing and Upgrading 
Adapters, page 2-38

Table 1-4 DFM 1.2 Updated for Common Services Version 2.2 Upgrade Roadmap (continued)

If you want to 
upgrade to... And... You must... For instructions, refer to...
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DFM 1.2 
Updated for 
Common 
Services 
Version 2.2

You also want to 
upgrade your 
remote operating 
system from a local 
operating system 
that has not been 
upgraded1,2

1. Upgrade your remote 
operating system and 
install any required 
patches

Your vendor documentation

2. Determine if all 
installed remote 
applications are 
supported by 
CD One, 5th Edition 
or Common 
Services 2.2, and 
upgrade them if 
required.

Appropriate documentation

3. Install CD One, 
5th Edition or 
Common Services 2.2 
remotely

Installation and Setup Guide for 
CD One on Windows or 
Installation and Setup Guide for 
CiscoWorks Common Services 
(Includes CiscoView) on 
Windows

4. Export local CD One, 
4th Edition 
information to the 
upgraded CD One, 
5th Edition or 
Common Services 2.2 
remote host

Installation and Setup Guide for 
CD One on Windows or
Installation and Setup Guide for 
CiscoWorks Common Services 
(Includes CiscoView) on 
Windows

5. Install DFM 1.2 
Updated for Common 
Services Version 2.2 
remotely

Performing a New Installation, 
page 2-2

Table 1-4 DFM 1.2 Updated for Common Services Version 2.2 Upgrade Roadmap (continued)

If you want to 
upgrade to... And... You must... For instructions, refer to...
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Installation Paths
You can install DFM 1.2 on:

• CD One, 5th Edition (as a standalone DFM)

• Resource Manager Essentials 3.4

You can install DFM 1.2 Updated for Common Services Version 2.2 on:

• CD One, 5th Edition (as a standalone DFM)

• Common Services 2.2 (as a standalone DFM)

• Resource Manager Essentials 3.5

To support integration with remote HP OpenView and NetView, and to support 
device list synchronization with remote Essentials systems, you must also install 
individual adapters on the remote NMS machines. For more information, refer to 
the “Installing and Upgrading Adapters” section on page 2-38.

DFM 1.2 
Updated for 
Common 
Services 
Version 2.2 
(continued)

You also want to 
upgrade your 
remote operating 
system from a local 
operating system 
that has not been 
upgraded

6. Export DFM 
information to the 
upgraded DFM 1.2 
Updated for Common 
Services Version 2.2 
remote host

Exporting Local DFM 
Information to an Upgraded 
Remote DFM Host, page 2-24 

1. If DFM 1.2 is currently installed, instead of installing from the CD, download the latest IDU from the DFM download page 
at http://www.cisco.com/en/US/products/sw/cscowork/ps2421/prod_upgrades_and_downloads.html. The IDU contains the 
same functionality as DFM 1.2 Updated for Common Services Version 2.2.

2. If you choose to upgrade to Common Services 2.2 and your DFM has an IDU later than DFM 1.2 IDU 1.2.3, you will not lose 
any existing device support.

Table 1-4 DFM 1.2 Updated for Common Services Version 2.2 Upgrade Roadmap (continued)

If you want to 
upgrade to... And... You must... For instructions, refer to...
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Server Requirements and Recommendations
The server system requirements for installing DFM 1.2 are shown in Table 1-5. 
These requirements apply when installing DFM on:

• CD One, 5th Edition

• Resource Manager Essentials 3.4 when the Availability application is not 
running

The server system requirements for installing DFM 1.2 Updated for Common 
Services Version 2.2 are shown in Table 1-6. These requirements apply when 
installing DFM on:

• CD One, 5th Edition

• Common Services 2.2

• Resource Manager Essentials 3.5 when the Availability application is not 
running

Table 1-5 and Table 1-6 also provide configuration recommendations when 
running DFM with CD One, Essentials, or Common Services. These major 
considerations can help you select or configure a server system that best meets 
your needs:

• The number of ports being managed. Configurations of over 30,000 ports (of 
which 15% are trunk ports) are not supported.

Note If you use the RME Adapter to synchronize the DFM inventory with 
a list of Essentials devices, and the synchronization causes DFM to 
exceed this limit, the Essentials device list will be truncated. (Refer 
to the “Supported NMS Environments for Device Import” section on 
page 1-21.)

To find out how many trunk and access ports are currently imported into 
DFM, use the sm_tpmgr command (described in more detail in the User 
Guide for Device Fault Manager, available from online help):

# NMSROOT\objects\smarts\bin\sm_tpmgr.exe --server=DFM --sizes
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Locate the line that is similar to the following:

Number of Ports: 761 [92/92]

In this example, 761 represents the number of discovered ports, out of which 
92 are managed. Unless you have reconfigured DFM to manage access ports, 
you can assume these 92 ports are trunk ports.

• Whether you plan to use DFM with the Essentials Availability application. (If 
you plan to use Availability, you must run Essentials and DFM on different 
machines.)

Note If you are installing DFM with the contents of a Cisco product bundle, the server 
requirements may be different. See the Read Me First document or the quick start 
guide for the appropriate bundle for additional information.
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Table 1-5 DFM 1.2 Server System Requirements and Recommendations

Requirement Type Required or Recommended Configuration 

System Hardware • IBM PC-compatible computer with 450 MHz Intel Pentium 
processor

• Color monitor

• CD-ROM drive

Memory (RAM) • 512 MB

Available Drive Space • 4 GB

• Swap space equal to double the amount of memory (RAM). For 
example, if your system has 512 MB of RAM, you need 1024 MB 
of swap space.

• NTFS file system required for secure operation.

System Software • Windows 2000 Professional and Server with Service Pack 2

Note DFM supports only US-English and Japanese versions of 
Windows operating systems. DFM does not support any other 
language versions. Set the default locale to US-English or 
Japanese.

Additional Software 
(Optional)

One of the following browsers (if you are using the CiscoWorks 
desktop on the server system):

• Microsoft Internet Explorer 5.5 with Service Pack 2, or Microsoft 
Internet Explorer 6.0

• Netscape Navigator 4.77, 4.78, or 4.79
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Table 1-6 DFM 1.2 Updated for Common Services Version 2.2 Server System Requirements and 

Recommendations

Requirement Type
Required or Recommended 
Configuration for CD One

Required or Recommended 
Configuration for Common Services 2.2 
and Essentials 3.5

System Hardware • IBM PC-compatible computer 
with 450 MHz Intel Pentium 
processor

• Color monitor

• CD-ROM drive

• IBM PC-compatible computer 
with 500 MHz Intel Pentium 
processor

• Color monitor

• CD-ROM drive

Memory (RAM) • 512 MB 512 MB

Available Drive 
Space1

• 4 GB

• Swap space equal to double the 
amount of memory (RAM). For 
example, if your system has 
512 MB of RAM, you need 
1024 MB of swap space.

• NTFS file system required for 
secure operation.

• 4 GB

• Paging file space equal to double 
the amount of memory (RAM). For 
example, if your system has 
256 MB of RAM, you need 
512 MB of page file.

• NTFS file system required for 
secure operation.

• At least 16 MB in Windows 
temporary directory (%TEMP%).

System Software2,3 • Windows 2000 Professional and 
Server with Service Pack 2

• ODBC Driver Manager 3.5.10.

• Windows 2000 Professional; 
Windows 2000 Server with 
Service Pack 3; Windows 2000 
with Service Pack 44

• Windows Advanced Server 
without enabling terminal services.
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Note Installation will continue with a warning message on Windows Advanced Server 
if terminal services are enabled in remote admin mode, but will abort when 
terminal services are enabled in application mode.

Do not use nonstandard java options through the _JAVA_OPTIONS environment 
variable.

Additional Software 
(Optional)

Browsers

• Microsoft Internet Explorer 5.5 
with Service Pack 2, or 
Microsoft Internet Explorer 6.0.

• Microsoft Internet Explorer 6.0 
(version 6.0.2600.0000); Internet 
Explorer 6.0 with Service Pack 1 
(version 6.0.2800.1106); Java 
Virtual Machine (JVM) 5.1.3182; 
Java plug-in version 1.3.1; Java 
plug-in version 1.4.1_024

To verify the JVM, select 
View> Java Console from Internet 
Explorer.

• Netscape Navigator 4.77, 4.78, 
or 4.79.

• Netscape Navigator 4.78; 
Netscape Navigator 4.79; 
Netscape Navigator 7.14

1. Do not install CiscoWorks on a FAT file system.

2. For Common Services installations, you cannot install CiscoWorks on a system configured as a primary or backup domain 
controller or as a terminal server. Do not install CiscoWorks in an encrypted directory. CiscoWorks do not support directory 
encryption. 

3. DFM supports only US-English and Japanese versions of Windows operating systems. DFM does not support any other 
language versions. Set the default locale to US-English or Japanese.

4. This is supported if you have installed the LAN Management Solution 2.2 Update 1. You can download the update by logging 
into Cisco.com and selecting Products and Services > Network Management CiscoWorks > CiscoWorks LAN 
Management Solution Software > Software Center > Download Software Image > LMS Bundle Downloads..

Table 1-6 DFM 1.2 Updated for Common Services Version 2.2 Server System Requirements and 

Recommendations (continued)

Requirement Type
Required or Recommended 
Configuration for CD One

Required or Recommended 
Configuration for Common Services 2.2 
and Essentials 3.5
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Client Requirements
The minimum system requirements for the CiscoWorks client are shown in 
Table 1-7.

Table 1-7 Client System Requirements Summary

Requirement Type Minimum Requirements for CD One
Minimum Requirements for 
Common Services 2.2

System Hardware 
and Software

Client system: Any of the following 
with video cards set to 256 colors:

Tip Use Windows clients for 
optimal performance.

• IBM PC-compatible computer 
with 450 MHz Pentium processor 
running:

– Windows NT 4.0 Workstation 
and Server with Service 
Pack 6a.

– Windows 98.

– Windows 2000 Professional 
and Server with Service 
Pack 2.

• SPARC Ultra 10 running 
Solaris 2.7 or Solaris 2.8.

• IBM RS/6000 workstation running 
AIX 4.3.3.

• HP900 workstation running 
HP-UX 11.0.

Client system: Any of the following 
with video card set to 256 colors:

Tip Use Windows clients for 
optimal performance.

• IBM PC-compatible computer 
with at least a 300 MHz Pentium 
processor running:

– Windows 2000 with Service 
Pack 3 (Professional and 
Server).

– Windows 2000 with Service 
Pack 41.

– Windows XP with Service 
Pack 1.

– Windows XP with 
ServicePack 1a1.

DFM supports English and 
Japanese Windows OS as clients.

• SPARC Ultra 10 running 
Solaris 2.7 or 2.8.
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Memory (RAM) 128 MB 256 MB

Browser On clients running Windows NT 4.0 
Workstation and Server with Service 
Pack 6a, Windows 98, Windows 2000 
Professional and Server with Service 
Pack 2:

• Microsoft Internet Explorer 5.5 
with Service Pack 2, or Microsoft 
Internet Explorer 6.0.

• Java Virtual Machine (JVM) 
version 5.0.0.3182 or current 
shipping version.

To verify the JVM version, select 
View> Java Console.

• Netscape Navigator 4.77, 
Netscape Navigator 4.78, or 
Netscape Navigator 4.79.

On Solaris clients (Solaris 2.7 and 2.8):

• Netscape Navigator 4.76.

On AIX 4.3.3, HP-UX 11.0 clients: 

• Netscape Navigator 4.77, 
Netscape Navigator 4.78, or 
Netscape Navigator 4.79.

On clients running Windows and 
Windows XP:

• Microsoft Internet Explorer 6.0 
(version 6.0.2600.0000), or 
Internet Explorer 6.0 with Service 
Pack 1 (version 6.0.2800.1106).

• Java Virtual Machine (JVM) 
5.1.3182, Java plug-in 
version 1.3.1, or Java plug-in 
version 1.4.1_021.

To verify the JVM version , select 
View> Java Console from Internet 
Explorer and 
Tools> Server >Java Console 
from Netscape Navigator.

• Netscape Navigator 4.78, 
Netscape Navigator 4.79, or 
Netscape Navigator 7.11.

On Solaris clients (Solaris 2.7 and 2.8): 

• Netscape Navigator 4.76, or 
Netscape Navigator 7.01.

Caution Use Netscape Navigator 
downloaded from the Sun 
Microsystems website only.

1. This is supported if you have installed the LAN Management Solution 2.2 Update 1. You can download the update by logging 
into Cisco.com and selecting Products and Services > Network Management CiscoWorks > CiscoWorks LAN 
Management Solution Software > Software Center > Download Software Image > LMS Bundle Downloads.

Table 1-7 Client System Requirements Summary (continued)

Requirement Type Minimum Requirements for CD One
Minimum Requirements for 
Common Services 2.2
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Supported NMS Environments for Device Import
DFM can synchronize the DFM inventory with a list of devices managed by local 
or remote versions of Resource Manager Essentials 3.5. If the import causes the 
DFM system to exceed its device limit, the Essentials list will be truncated. (Refer 
to “Server Requirements and Recommendations” section on page 1-14.)

Synchronizing is done automatically if you install DFM on the same host that is 
running Essentials, or if you locally install Essentials later. If Essentials is 
running on a remote host, you must install the RME Adapter on the remote 
Essentials host as described in the “Installing or Upgrading the RME Adapter on 
a Remote Host” section on page 2-46.

Supported NMS Integration
DFM includes several adapters that collect inventory information, gather network 
event information, and send event notifications to the domain manager or other 
SNMP recipients, such as NMSs. The adapters are automatically installed when 
you install DFM.

NMS integration adapters include:

• SNMP Trap Adapter, which listens on a user-specified port for traps sent to 
DFM from managed devices, and forwards the traps to specified destinations. 
(Configuring this adapter is described in the “Enabling DFM to Send Traps 
to NMSs” section on page 3-2.)

• HPOV-NetView Adapter, which forwards traps (sent from managed devices 
to the NMS) to DFM from remote or local hosts running:

– HP OpenView 6.2

– NetView 6.01

– NetView 7.1 (supported only on DFM 1.2 Updated for Common 
Services Version 2.2 when it is installed on CiscoWorks Common 
Services 2.2)
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For remote machines without CiscoWorks the remote HPOV-NetView adapter is 
supported on:

• For DFM 1.2:

– Solaris 2.7 or 2.8 

– Windows 2000 Professional or Server with Service Pack 2 

• For DFM 1.2 Updated for Common Services Version 2.2:

– Solaris 2.7 or 2.8 

– Windows 2000 Professional or Server with Service Pack 3 or higher; 
Windows Advanced Server

Installing this adapter on remote machines is described in the “Installing or 
Upgrading the HPOV-NetView Adapter on a Remote Host” section on page 2-41.

Note To use the HPOV-NetView Adapter with a local version of HP OpenView or 
NetView, make sure that HP OpenView or NetView is installed before you install 
DFM.

If the standard UDP trap port (162) is being used by another NMS, you must 
configure the SNMP Trap Adapter to use a different UDP port, such as port 9000. 
Refer to the “Configuring the SNMP Trap Adapter” section on page 3-3.

Supported Devices
Device adapter packages for all supported devices are installed when you install 
DFM. Information about devices installed with DFM can be found at

http://www.cisco.com/en/US/products/sw/cscowork/ps2421/products_device_su
pport_tables_list.html

You can download device packages for new devices from Cisco.com and find 
information about all supported devices by logging into Cisco.com at

http://www.cisco.com/cgi-bin/tablebuild.pl/cw2000-dfm.
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Device packages are released cumulatively; that is, new device packages contain 
the contents of any previous packages.

To determine which packages are installed on your CiscoWorks Server, select 
Server Configuration > About the Server > Applications and Versions.

You can also obtain any published patches from the download site.
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C H A P T E R 2

Installing Device Fault Manager

This chapter describes installing Device Fault Manager (DFM) on a Windows 
system. It includes:

• Performing a New Installation, page 2-2

• Upgrading Device Fault Manager, page 2-12

• Reinstalling Device Fault Manager, page 2-27

• Removing Device Fault Manager, page 2-37

• Installing and Upgrading Adapters, page 2-38

• Removing Adapters, page 2-49

This chapter contains instructions for installing both DFM 1.2 and DFM 1.2 
Updated for Common Services Version 2.2. Differences in the installations are 
noted. Keep the following in mind when deciding whether to upgrade to DFM 1.2 
Updated for Common Services Version 2.2:

• Upgrading from DFM 1.2 to DFM 1.2 Updated for Common Services 
Version 2.2 allows your system to manage devices that were not supported 
when DFM 1.2 was released, and also provides a number of DFM bug fixes. 
The devices and bug fixes are listed in the Release Notes for Device Fault 
Manager 1.2 Updated for Common Services Version 2.2 on Windows.

• If you do not plan to upgrade to Common Services 2.2, it may be easier to 
download and install the latest DFM IDU from: 
http://www.cisco.com/en/US/products/sw/cscowork/ps2421/prod_upgrades
_and_downloads.html.
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The IDU includes the same functionality as DFM 1.2 Updated for Common 
Services Version 2.2, plus additional device support and bug fixes. (If you do 
upgrade to Common Services 2.2, you can always download and install the 
DFM IDU after upgrading or re-enabling DFM from the CD.)

• If you upgrade to DFM 1.2 Updated for Common Services Version 2.2, and 
your system contains installed IDUs that were released after DFM 1.2.3, you 
will not lose any existing device support.

Performing a New Installation
This section explains how to perform these new installations:

• Performing a New Installation of DFM 1.2, page 2-2

• Performing a New Installation of DFM 1.2 Updated for Common Services 
Version 2.2, page 2-9

Performing a New Installation of DFM 1.2
Follow these steps to perform a new DFM 1.2 installation on a Windows system.

Step 1 Make sure your system meets these prerequisites:

• Required (or desired) operating system upgrades have been performed, and 
required service packs are installed.

• All installed applications are supported by CD One, 5th Edition. Applications 
not supported by CD One, 5th Edition will be disabled when you upgrade 
CD One. 

• CD One, 5th Edition has been installed. (Refer to Installation and Setup 
Guide for CD One on Windows.)
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• If desired, HP OpenView or NetView has been installed (to use the 
HPOV-NetView Adapter with a local version of HP OpenView or NetView).

Note NetView must be installed on the same drive as DFM (for local 
integration) or on the same drive as the HPOV-NetView Adapter (for 
remote integration).

• If HP OpenView is installed and operational, stop all HP OpenView services 
(or the installation will take significantly longer).

Step 2 Close all open or active programs. Do not run other programs during the 
installation process.

Step 3 As the local administrator, log on to the machine on which you will install the 
DFM software, and insert the DFM CD-ROM into the CD-ROM drive. The 
installer window appears, asking you if you want to install DFM.

Note If the CD-ROM is already in the CD-ROM drive and you stopped the 
installation process to close programs or if Autostart is disabled, click 
Setup.exe to restart the process.

Step 4 Click Install. The Welcome window appears.

Step 5 Click Next. The Setup Type dialog box appears.

Step 6 Select Typical to install the complete DFM package, which contains DFM, the 
DFM incremental device support base package, the HPOV-NetView Adapter, and 
the RME Adapter. (For more information on installation components, refer to 
Table 1-1 on page 1-2.)

Step 7 Click Next. The Start Copying Files window appears.

Step 8 Click Next. The installation program checks dependencies and system 
requirements.
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Step 9 The Requirements Verification dialog box displays the results of the requirements 
check and advises whether the installation can continue. One of the following 
should then occur:

• If minimum requirements are met, click OK. The Setup screen appears, 
displaying installation progress while files are copied. The Setup Complete 
dialog box appears.

• If recommended requirements are not met, an error message appears. To 
continue the installation, click OK.

If DFM detects another application using port 162, DFM displays the following 
message:

WARNING: Installation has detected port 162 in use. DFM is set to use 
port 9000 for receiving SNMP traps.

If you see this message, after the installation completes, you must configure the 
SNMP Trap Adapter to use a different UDP port, such as port 9000. (Refer to the 
“Configuring the SNMP Trap Adapter” section on page 3-3.)

Step 10 A dialog box appears, asking if you want to connect this instance of DFM with 
VHM 1.0. Do one of the following:

• If you will be using a remote version of VHM 1.0 with DFM, click Yes.

The installation program copies the files to the CiscoWorks default 
installation directory C:\Program Files\CSCOpx (NMSROOT). The Restart 
window appears.

Proceed to Step 13.

• If you will not be using a remote version of VHM 1.0 with DFM, click No. 
Proceed to Step 11.

Note You must give the same answer to this question when you install adapters. 
If you answer No and provide a DFM username and password, you must 
provide the same username and password pair when you install adapters.
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Step 11 The Setup window appears. In the username field, enter the DFM username. In 
the password field, enter the DFM password. 

Note You can change your username and password. Refer to the User Guide for 
Device Fault Manager, available from the online help, for more 
information.

Step 12 Click Next. The installation program copies the files to the CiscoWorks default 
installation directory C:\Program Files\CSCOpx (NMSROOT). The Restart 
window appears.

Step 13 Remove the DFM CD-ROM from the drive, and store the CD-ROM in a secure, 
climate-controlled area for safekeeping.

Step 14 Click Finish to reboot the machine.

Step 15 Specify the clients that are allowed to connect to the DFM server. (DFM provides 
this fine-grain control as an additional security feature.)

a. Unregister the daemons with the daemon manager:

– For DFM notification adapters:

# NMSROOT\bin\pdcmd.exe -u DfmFileNotifier
# NMSROOT\bin\pdcmd.exe -u DfmTrapNotifier
# NMSROOT\bin\pdcmd.exe -u DfmMailNotifier

– For DfmServer:

# NMSROOT\bin\pdcmd.exe -u DfmServer

– For DfmBroker:

# NMSROOT\bin\pdcmd.exe -u DfmBroker

b. Decide which hosts you want to specify using the --accept option with 
arguments shown in Table 2-1.

Note If you specify registration options using pdcmd, you must re-run your 
command whenever the daemon manager restarts.
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For example, this command fragment would allow connections only from 
hosts lucy and ethel:

--accept=lucy,ethel

Note To allow connections from processes running on the same host, 
specify the host's name—do not use “localhost.” This is because 
connections made using the DFM Broker will appear to come from 
the DFM Broker’s host. Only connections that explicitly specify 
“localhost” as the target address will appear to come from localhost. 
Such target addresses may result in configurations that forward 
incoming connections (such as through software that provides an 
encrypted tunnel).

Table 2-1 Arguments to the --accept Option

Argument Description

host1,host2,... Allow only host1,host2,... to connect to the server. If the 
hostname is registered with DNS, you can specify the client 
by hostname. Otherwise, specify explicit IP addresses in a 
comma-separated list. Hostnames are resolved to one or more 
IP addresses, which are then used (the server does not use 
reverse lookups to determine the name of a connecting host).

Note If you specify the clients as hostnames, be sure the 
hostname is registered with DNS, especially if you 
are using DHCP.

=any Allow all incoming connections (default).
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c. Re-register the daemons with the daemon manager, specifying the clients that 
can connect to the broker and server (in this example, the DFM broker port is 
9002 and lucy and ethel are the clients):

– For DfmBroker (the following command is one line):

# NMSROOT\bin\pdcmd.exe -r DfmBroker -e NMSROOT\objects\smarts\bin\brstart.exe -f 
"--output --port=9002 --accept=lucy,ethel 
--restore=NMSROOT\objects\smarts\conf\broker.rps"

– For DfmServer (the following command is one line):

# NMSROOT\bin\pdcmd.exe -r DfmServer -e NMSROOT\objects\smarts\bin\sm_server.exe -d 
DfmBroker -f "--bootstrap=DFM_bootstrap.conf --accept=lucy,ethel --output --name=DFM"

– For DFM notification adapters (the following commands are each one 
line, and will register the adapter processes to automatically start upon 
reboot):

# NMSROOT\bin\pdcmd.exe -r DfmFileNotifier -d DfmServer -e 
NMSROOT\objects\smarts\bin\sm_notify.exe -f "--adapter=filelog --output=sm_file_notifier"

# NMSROOT\bin\pdcmd.exe -r DfmTrapNotifier -d DfmServer -e 
NMSROOT\objects\smarts\bin\sm_notify.exe -f "--adapter=trap --output=sm_trap_notifier"

# NMSROOT\bin\pdcmd.exe -r DfmMailNotifier -d DfmServer -e 
NMSROOT\objects\smarts\bin\sm_notify.exe -f "--adapter=mail --output=sm_mail_notifier"

If you do not want the daemons to start after a reboot, add the -n option 
to the end of the command, as in this File Notifier Adapter example:

# NMSROOT\bin\pdcmd.exe -r DfmFileNotifier -d DfmServer -e 
NMSROOT\objects\smarts\bin\sm_notify.exe -f "--adapter=filelog --output=sm_file_notifier" 
-n

d. Make sure that the client names and current IP addresses are registered with 
DNS if one or both of the following apply:

– You are running DHCP 

– You specified the clients with hostnames
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Step 16 To verify that the DfmServer process is running, log on to the CiscoWorks 
desktop as the administrator and select Server Configuration >
Administration >Process Management> Process Status.

Note If your client does not have the Java plug-in, you will receive a message 
asking if you want to install it. The plug-in is required for DFM 1.2.

Step 17 If you plan to use remote adapters with Device Fault Manager 1.2, perform these 
steps:

a. Make sure the machine running the DfmBroker is registered with DNS.

b. Install all remote adapters as described in the “Installing and Upgrading 
Adapters” section on page 2-38.

Step 18 To use DFM, select Device Fault Manager from the CiscoWorks navigation tree.

If the standard UDP trap port (162) is being used by another NMS, you must 
configure the SNMP Trap Adapter to use a different UDP port, such as port 9000. 
Refer to the “Configuring the SNMP Trap Adapter” section on page 3-3.

If you install another NMS after installing DFM, you must:

1. Configure DFM to forward traps to the listening port for the NMSs. Refer to 
the “Enabling DFM to Send Traps to NMSs” section on page 3-2.

2. Make sure the NMSs are configured to receive traps at the port you specify 
in Step 1. Refer to the appropriate documentation for the NMS.

When HP OpenView or NetView is restarted, CiscoWorks automatically 
configures the adapters to foward SNMP traps from HP OpenView or NetView to 
DFM. If you install HP OpenView or NetView later, you will have to either 
configure the SNMP Trap Adapter to use another port (as described in the 
“Configuring the SNMP Trap Adapter” section on page 3-3), or reinstall DFM.

If a local version of Essentials is already installed (or is installed later), 
CiscoWorks automatically configures the adapters to forward Essentials 
inventory device information to DFM. To do this with remote versions of 
HP OpenView, NetView, or Essentials, you must install the remote adapters as 
described in the “Installing and Upgrading Adapters” section on page 2-38.
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If you had any errors during installation, check the installation log in the root 
directory on the drive where the operating system is installed. Each installation 
creates a new log file. (For example, the CiscoWorks installation might create 
C:\cw2000_in001.log, the DFM installation might create C:\cw2000_in002.log, 
and so forth.) The Technical Assistance Center (TAC) might ask you to send them 
the installation log.

Performing a New Installation of DFM 1.2 Updated for Common 
Services Version 2.2

Follow these steps to perform a new installation of DFM 1.2 Updated for 
Common Services Version 2.2 on a Windows system.

Note You can also use this procedure to upgrade from DFM 1.2 to DFM 1.2 Updated 
for Common Services Version 2.2 (as described in the “Upgrading DFM 1.2 to 
DFM 1.2 Updated for Common Services Version 2.2” section on page 2-23).

Step 1 Make sure your system meets these prerequisites:

• Required (or desired) operating system upgrades have been performed, and 
required service packs are installed.

• All installed applications are supported by CD One, 5th Edition, or Common 
Services 2.2. Applications not supported by CD One, 5th Edition, or 
Common Services 2.2, will be disabled when you upgrade CD One. 

• CD One, 5th Edition, or Common Services 2.2 has been installed. (Refer to 
Installation and Setup Guide for CD One on Windows or Installation and 
Setup Guide for CiscoWorks Common Services (Includes CiscoView) on 
Windows.)
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• If desired, HP OpenView or NetView has been installed (to use the 
HPOV-NetView Adapter with a local version of HP OpenView or NetView).

Note NetView must be installed on the same drive as DFM (for local 
integration) or on the same drive as the HPOV-NetView Adapter (for 
remote integration).

• If HP OpenView is installed and operational, stop all HP OpenView services 
(or the installation will take significantly longer).

Step 2 Close all open or active programs. Do not run other programs during the 
installation process.

Step 3 As the local administrator, log on to the machine on which you will install the 
DFM software, and insert the DFM CD-ROM into the CD-ROM drive. The 
installer window appears, asking you if you want to install DFM.

Note If the CD-ROM is already in the CD-ROM drive and you stopped the 
installation process to close programs or if Autostart is disabled, click 
Setup.exe to restart the process.

Step 4 Click Install. The Welcome window appears.

Step 5 Click Next. The Software License Agreement window appears.

Note You may be asked to validate your DFM image if you are installing DFM 
using a Maintenance Kit CD (for CiscoWorks LAN Management 
Solution 2.2). If you are prompted to validate the image, insert a DFM 1.2 
(or earlier) CD into one of your system drives. (If autoplay is enabled, a 
new installation window will open whenever a CD is inserted. Click 
Cancel in each new installation window.) If the DFM image cannot be 
validated —that is, if you do not have a DFM 1.2 (or earlier) CD— the 
installation cannot proceed. Contact your Cisco sales representative.

Step 6 To accept the agreement and continue the installation, click Yes. 
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Step 7 If your system contains installed IDUs that were released after DFM 1.2.3 (such 
as DFM 1.2 IDU 1.2.4), the Enable DFM window opens, displaying the following 
message:

The installation program has detected a newer version of DFM already 
on your system. The newer version is disabled. Do you want to enable 
it?
Click “Yes” to enable the newer version of DFM.
Click “No” to abort the installation.

Do one of the following:

• To enable DFM, click Yes. Because continuing the installation would add no 
new functionality, further DFM installation is not required, and the 
installation program exits. To re-establish settings that were lost when 
CiscoWorks Common Services 2.2 was installed (and DFM was disabled), 
proceed to Step 15 in the “Performing a New Installation of DFM 1.2” 
section on page 2-2.

• To keep DFM disabled, select No. DFM remains disabled, and the installation 
program exits.

Step 8 The Setup Type dialog box appears. Select Typical to install the complete DFM 
package, which contains DFM, the DFM incremental device support base 
package, the HPOV-NetView Adapter, and the RME Adapter. (For more 
information on installation components, refer to Table 1-1 on page 1-2.) 

Step 9 Click Next. The installation program checks dependencies and system 
requirements.

Step 10 The System Requirements window appears, displays the results of the 
requirements check, and advises whether installation can continue. One of the 
following should then occur:

• If minimum requirements are met, click Next. 

• If recommended requirements are not met, an error message appears. To 
continue the installation, click Next.
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Step 11 The Summary dialog box displays your selected settings. Click Next. 

Step 12 The Setup window appears, displaying installation progress while files are 
copied. 

If DFM detects another application using port 162, DFM displays the following 
message:

WARNING: Installation has detected port 162 in use. DFM is set to use 
port 9000 for receiving SNMP traps.

If you see this message, after the installation completes, you must configure the 
SNMP Trap Adapter to use a different UDP port, such as port 9000. (Refer to the 
“Configuring the SNMP Trap Adapter” section on page 3-3.)

Step 13 To finish installing DFM 1.2 Updated for Common Services Version 2.2, follow 
Step 10 through Step 18 in the “Performing a New Installation of DFM 1.2” 
section on page 2-2.

Upgrading Device Fault Manager 
Refer to these sections for procedures on how to perform these upgrades:

• Upgrading DFM 1.1 to DFM 1.2, page 2-12

• Upgrading DFM 1.1 to DFM 1.2 Updated for Common Services Version 2.2, 
page 2-20

• Upgrading DFM 1.2 to DFM 1.2 Updated for Common Services Version 2.2, 
page 2-23

• Exporting Local DFM Information to an Upgraded Remote DFM Host, 
page 2-24

Upgrading DFM 1.1 to DFM 1.2
You can upgrade Device Fault Manager 1.1 (installed with or without IDS 1.1.x 
patches) on local or remote machines. If desired, you can upgrade a remote 
machine and then export your local DFM information to the upgraded remote 
machine.
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When you upgrade a local version of DFM 1.1 to DFM 1.2, the upgrade program 
saves and restores the DFM 1.1 seed file, adapter files, repository, and consoles. 
If desired, you can manually restore the log files from 
NMSROOT\objects\smarts\logs.

Note Customized remote consoles are not saved after upgrade.

Follow these steps to upgrade a local host to DFM 1.2:

Step 1 Make sure your system meets these prerequisites:

• Required (or desired) operating system upgrades have been performed, and 
required service packs are installed.

• All installed applications are supported by CD One, 5th Edition. Applications 
not supported by CD One, 5th Edition will be disabled when you upgrade 
CD One. 

• CD One, 5th Edition has been installed. (Refer to Installation and Setup 
Guide for CD One on Windows.)

• If desired, HP OpenView or NetView has been installed (to use the 
HPOV-NetView Adapter with a local version of HP OpenView or NetView).

Note NetView must be installed on the same drive as DFM (for local 
integration) or on the same drive as the HPOV-NetView Adapter (for 
remote integration).

• If HP OpenView is installed and operational, all HP OpenView services have 
been stopped. (If not, the installation will take significantly longer).

Step 2 Close all open or active programs. Do not run other programs during the 
reinstallation process.
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Step 3 As the local administrator, log on to the machine on which you will install the 
DFM software, and insert the DFM CD-ROM into the CD-ROM drive. The 
installer window appears, asking you if you want to install DFM.

Note If the CD-ROM is already in the CD-ROM drive and you stopped the 
installation process to close programs or if Autostart is disabled, click 
Setup.exe to restart the process.

Step 4 Click Install. The Welcome window appears.

Step 5 Click Next. The Setup Type dialog box appears.

Step 6 Select Typical to upgrade the complete DFM package, which contains DFM, the 
DFM incremental device support base package, the HPOV-NetView Adapter, and 
the RME Adapter. (For more information on upgrade components, refer to 
Table 1-1 on page 1-2.)

Step 7 Click Next. The Start Copying Files window appears.

Step 8 Click Next. The installation program checks dependencies and system 
requirements.

Step 9 The Requirements Verification dialog box displays the results of the requirements 
check and advises whether the installation can continue. One of the following 
should then occur:

• If minimum requirements are met, click OK. The Setup screen appears, 
displaying installation progress while files are copied. The Setup Complete 
dialog box appears.

• If recommended requirements are not met, an error message appears. To 
continue the installation, click OK.

• If DFM detects another application using port 162, DFM displays the 
following message:

WARNING: Installation has detected port 162 in use. DFM is set to use 
port 9000 for receiving SNMP traps.

If you see this message, after the installation completes, you must configure the 
SNMP Trap Adapter to use a different UDP port, such as port 9000. (Refer to the 
“Configuring the SNMP Trap Adapter” section on page 3-3.)
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Step 10 A dialog box appears, asking if you want to connect this instance of DFM with 
VHM 1.0. Do one of the following:

• If you will be using a remote version of VHM 1.0 with DFM, click Yes.

The installation program copies the files to the CiscoWorks default 
installation directory C:\Program Files\CSCOpx (NMSROOT).

Proceed to Step 13.

• If you will not be using a remote version of VHM 1.0 with DFM, click No. 
Proceed to Step 11.

Note You must give the same answer to this question when you install adapters. 
If you answer No and provide a DFM username and password, you must 
provide the same username and password pair when you install adapters.

Step 11 The Setup window appears. In the username field, enter the DFM username. In 
the password field, enter the DFM password. 

Note You can change your username and password. Refer to the User Guide for 
Device Fault Manager, available from the online help, for more 
information.

Step 12 Click Next. The installation program copies the files to the CiscoWorks default 
installation directory C:\Program Files\CSCOpx (NMSROOT).

Step 13 A dialog box appears, reminding you to run rediscovery from the Administration 
Console; this procedure is described in Step 19. Click OK. The Restart window 
appears.

Step 14 Remove the DFM CD-ROM from the drive, and store the CD-ROM in a secure, 
climate-controlled area for safekeeping.

Step 15 Click Finish to reboot the machine.

Note You must reboot the machine to make sure the DFM broker attaches to 
the correct port (9002).
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Step 16 Specify the clients that are allowed to connect to the DFM server. (DFM provides this 
fine-grain control as an additional security feature.)

a. Unregister the daemons with the daemon manager:

– For DFM notification adapters:

# NMSROOT\bin\pdcmd.exe -u DfmFileNotifier
# NMSROOT\bin\pdcmd.exe -u DfmTrapNotifier
# NMSROOT\bin\pdcmd.exe -u DfmMailNotifier

– For DfmServer:

# NMSROOT\bin\pdcmd.exe -u DfmServer

– For DfmBroker:

# NMSROOT\bin\pdcmd.exe -u DfmBroker

b. Decide which hosts you want to specify using the --accept option with 
arguments shown in Table 2-2.

Note If you specify registration options using pdcmd, you must re-run your 
command whenever the daemon manager restarts.

Table 2-2 Arguments to the --accept Option

Argument Description

host1,host2,... Allow only host1,host2,... to connect to the server. If the 
hostname is registered with DNS, you can specify the client 
by hostname. Otherwise, specify explicit IP addresses in a 
comma-separated list. Hostnames are resolved to one or more 
IP addresses, which are then used (the server does not use 
reverse lookups to determine the name of a connecting host).

Note If you specify the clients as hostnames, be sure the 
hostname is registered with DNS, especially if you 
are using DHCP.

=any Allow all incoming connections (default).
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For example, this command fragment would allow connections only from 
hosts lucy and ethel:

--accept=lucy,ethel

Note To allow connections from processes running on the same host, 
specify the host's name—do not use “localhost.” This is because 
connections made using the DFM Broker will appear to come from 
the DFM Broker’s host. Only connections that explicitly specify 
“localhost” as the target address will appear to come from localhost. 
Such target addresses may result in configurations that forward 
incoming connections (such as through software that provides an 
encrypted tunnel).

c. Re-register the daemons with the daemon manager, specifying the clients that 
can connect to the broker and server (in this example, the DFM broker port is 
9002 and lucy and ethel are the clients):

– For DfmBroker (the following command is one line):

# NMSROOT\bin\pdcmd.exe -r DfmBroker -e NMSROOT\objects\smarts\bin\brstart.exe -f 
"--output --port=9002 --accept=lucy,ethel 
--restore=NMSROOT\objects\smarts\conf\broker.rps"

– For DfmServer (the following command is one line):

# NMSROOT\bin\pdcmd.exe -r DfmServer -e NMSROOT\objects\smarts\bin\sm_server.exe -d 
DfmBroker -f "--bootstrap=DFM_bootstrap.conf --accept=lucy,ethel --output --name=DFM"

– For DFM notification adapters (the following commands are each one 
line, and will register the adapter processes to automatically start upon 
reboot):

# NMSROOT\bin\pdcmd.exe -r DfmFileNotifier -d DfmServer -e 
NMSROOT\objects\smarts\bin\sm_notify.exe -f "--adapter=filelog --output=sm_file_notifier"

# NMSROOT\bin\pdcmd.exe -r DfmTrapNotifier -d DfmServer -e 
NMSROOT\objects\smarts\bin\sm_notify.exe -f "--adapter=trap --output=sm_trap_notifier"

# NMSROOT\bin\pdcmd.exe -r DfmMailNotifier -d DfmServer -e 
NMSROOT\objects\smarts\bin\sm_notify.exe -f "--adapter=mail --output=sm_mail_notifier"
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If you do not want the daemons to start after a reboot, add the -n option 
to the end of the command, as in this File Notifier Adapter example:

# NMSROOT\bin\pdcmd.exe -r DfmFileNotifier -d DfmServer -e 
NMSROOT\objects\smarts\bin\sm_notify.exe -f "--adapter=filelog --output=sm_file_notifier" 
-n

d. Make sure that the client names and current IP addresses are registered with 
DNS if:

– You are running DHCP and/or

– You specified the clients with hostnames

Step 17 To verify that the DfmServer process is running, log on to the CiscoWorks desktop 
as the administrator and select Server Configuration >Administration> Process 
Management> Process Status.

Note If your client does not have the Java plug-in, you will receive a message 
asking if you want to install it. The plug-in is required for DFM 1.2.

Step 18 Make sure the DFM broker has attached to the correct port:

a. Clear the browser cache.

b. Exit the browser.

c. Reopen the browser.

Step 19 Rediscover the devices in your DFM inventory by opening the Administration 
Console and selecting Inventory > Inventory Collect All.

Note Depending on the number of managed devices, rediscovering the entire 
DFM inventory could take several hours.
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Step 20 If you plan to use remote clients (such as adapters) with Device Fault 
Manager 1.2, perform these steps:

a. Make sure the machine running the DfmBroker is registered with DNS.

b. Upgrade all remote adapters as described in the “Installing and Upgrading 
Adapters” section on page 2-38. If the adapters are installed on a remote 
VHM 1.0 machine, they do not need to be upgraded.

c. For remote versions of VHM 1.0, restart the remote VHM server process.

Step 21 Proceed to the “Exporting Local DFM Information to an Upgraded Remote DFM 
Host” section on page 2-24.

If the standard UDP trap port (162) is being used by another NMS—such as Cisco 
Voice Manager, Traffic Director, or Real Time Monitor—you must configure the 
SNMP Trap Adapter to use a different UDP port, such as port 9000. Refer to the 
“Configuring the SNMP Trap Adapter” section on page 3-3.

If you install another NMS—such as Cisco Voice Manager, Traffic Director, or 
Real Time Monitor—after installing DFM, you must:

1. Configure DFM to forward traps to the listening port for the NMSs. Refer to 
the “Enabling DFM to Send Traps to NMSs” section on page 3-2.

2. Make sure the NMSs are configured to receive traps at the port you specify in 
Step 1. Refer to the appropriate documentation for the NMS.

When HP OpenView or NetView are restarted, CiscoWorks automatically 
configures the adapters to foward SNMP traps from HP OpenView and NetView 
to DFM. If you install HP OpenView or NetView later, you will have to either 
configure the SNMP Trap Adapter to use another port (as described in the 
“Configuring the SNMP Trap Adapter” section on page 3-3), or reinstall DFM.

If a local version of Essentials is already installed (or is installed later), 
CiscoWorks automatically configures the adapters to forward Essentials inventory 
device information to DFM. To do this with remote versions of HP OpenView, 
NetView, or Essentials, you must install the remote adapters as described in the 
“Installing and Upgrading Adapters” section on page 2-38.
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If you had any errors during upgrade, check the installation log in the root 
directory on the drive where the operating system is installed. Each installation 
creates a new log file. (For example, the CiscoWorks CD One installation might 
create C:\cw2000_in001.log, the DFM installation might create 
C:\cw2000_in002.log, and so forth.) The Technical Assistance Center (TAC) 
might ask you to send them the installation log.

Upgrading DFM 1.1 to DFM 1.2 Updated for Common Services 
Version 2.2

When you upgrade a local version of DFM 1.1 to DFM 1.2 Updated for Common 
Services Version 2.2, the upgrade program saves and restores the DFM 1.1 seed 
file, adapter files, repository, and consoles. If desired, you can manually restore 
the log files from NMSROOT\objects\smarts\logs. You can also upgrade a remote 
machine and then export your local DFM information to the upgraded remote 
machine (see the “Exporting Local DFM Information to an Upgraded Remote 
DFM Host” section on page 2-24).

Note Customized remote consoles are not saved after the upgrade.

Follow these steps to upgrade a local host to DFM 1.2 Updated for Common 
Services Version 2.2:

Step 1 Make sure your system meets these prerequisites:

• Required (or desired) operating system upgrades have been performed, and 
required service packs are installed.

• All installed applications are supported by CD One, 5th Edition, or Common 
Services 2.2. Applications not supported by CD One, 5th Edition, or 
Common Services 2.2, will be disabled when you upgrade CD One. 

• CD One, 5th Edition, or Common Services 2.2 has been installed. (Refer to 
Installation and Setup Guide for CD One on Windows or Installation and 
Setup Guide for CiscoWorks Common Services (Includes CiscoView) on 
Windows.)
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• If desired, HP OpenView or NetView has been installed (to use the 
HPOV-NetView Adapter with a local version of HP OpenView or NetView).

Note NetView must be installed on the same drive as DFM (for local 
integration) or on the same drive as the HPOV-NetView Adapter (for 
remote integration).

• If HP OpenView is installed and operational, all HP OpenView services have 
been stopped (if not, the installation will take significantly longer).

Step 2 Close all open or active programs. Do not run other programs during the 
reinstallation process.

Step 3 As the local administrator, log on to the machine on which you will install the 
DFM software, and insert the DFM CD-ROM into the CD-ROM drive. The 
installer window appears, asking you if you want to install DFM.

Note If the CD-ROM is already in the CD-ROM drive and you stopped the 
installation process to close programs or if Autostart is disabled, click 
Setup.exe to restart the process.

Step 4 Click Install. The Welcome window appears.

Step 5 Click Next.

Step 6 If you are installing DFM on Common Services Version 2.2, the Software License 
Agreement window appears. To accept the agreement and continue the 
installation, click Yes.

Note You may be asked to validate your DFM image if you are installing DFM 
using a Maintenance Kit CD (for CiscoWorks LAN Management 
Solution 2.2). If you are prompted to validate the image, insert a DFM 1.2 
(or earlier) CD into one of your system drives. (If autoplay is enabled, a 
new installation window will open whenever a CD is inserted. Click 
Cancel in each new installation window.) If the DFM image cannot be 
validated —that is, if you do not have a DFM 1.2 (or earlier) CD— the 
installation cannot proceed. Contact your Cisco sales representative.
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Step 7 The Setup Type dialog box appears. Select Typical to upgrade the complete DFM 
package, which contains DFM, the DFM incremental device support base 
package, the HPOV-NetView Adapter, and the RME Adapter. (For more 
information on upgrade components, refer to Table 1-1 on page 1-2.)

The installation program checks dependencies and system requirements.

Step 8 The System Requirements window appears, displays the results of the 
requirements check, and advises whether installation can continue. One of the 
following should then occur:

• If minimum requirements are met, click Next. 

• If recommended requirements are not met, an error message appears. To 
continue the installation, click Next.

Step 9 The Summary dialog box displays your selected settings. Click Next. 

Step 10 The Setup window appears, displaying installation progress while files are 
copied. 

If DFM detects another application using port 162, DFM displays the following 
message:

WARNING: Installation has detected port 162 in use. DFM is set to use 
port 9000 for receiving SNMP traps.

Step 11 To finish upgrading DFM 1.1 to DFM 1.2 Updated for Common Services 
Version 2.2, follow Step 10 through Step 21 in the “Upgrading DFM 1.1 to 
DFM 1.2” section on page 2-12.
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Upgrading DFM 1.2 to DFM 1.2 Updated for Common Services 
Version 2.2

You can upgrade Device Fault Manager 1.2, 1.2.1, or 1.2.2 on local or remote 
machines. To perform the upgrade, follow the procedure in the “Performing a New 
Installation of DFM 1.2 Updated for Common Services Version 2.2” section on 
page 2-9. You do not need to do any data preservation, nor do you need to upgrade 
any adapters, when upgrading from DFM 1.2 to DFM 1.2 Updated for Common 
Services Version 2.2.

Keep the following in mind when deciding whether to upgrade to DFM 1.2 
Updated for Common Services Version 2.2:

• Upgrading from DFM 1.2 to DFM 1.2 Updated for Common Services 
Version 2.2 allows your system to manage devices that were not supported 
when DFM 1.2 was released, and also provides a number of DFM bug fixes. 
The devices and bug fixes are listed in the Release Notes for Device Fault 
Manage 1.2 Updated for Common Services Version 2.2 on Windows.

• If you do not plan to upgrade to Common Services 2.2, it may be easier to 
download and install the latest DFM IDU from: 
http://www.cisco.com/en/US/products/sw/cscowork/ps2421/prod_upgrades_
and_downloads.html.

The IDU includes the same functionality as DFM 1.2 Updated for Common 
Services Version 2.2, plus additional device support and bug fixes. (If you do 
upgrade to Common Services 2.2, you can always download and install the 
DFM IDU after upgrading or re-enabling DFM from the CD.)

• If you upgrade to DFM 1.2 Updated for Common Services Version 2.2, and 
your system contains installed IDUs that were released after DFM 1.2.3, you 
will not lose any existing device support.

If desired, you can upgrade a remote machine and then export your local DFM 
information to the upgraded remote machine. See the “Exporting Local DFM 
Information to an Upgraded Remote DFM Host” section on page 2-24 for more 
information.
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Exporting Local DFM Information to an Upgraded Remote DFM 
Host

This procedure exports your local DFM configuration information and imports it 
to a remote DFM machine that has been upgraded. This procedure applies to the 
following scenarios:

• Exporting local DFM 1.1 information to a remote host running DFM 1.2

• Exporting local DFM 1.1 information to a remote host running DFM 1.2 
Upgraded for Common Services Version 2.2

• Exporting local DFM 1.2 information to a remote host running DFM 1.2 
Updated for Common Services Version 2.2

Step 1 As the local administrator, log on to the local DFM system, and insert the upgrade 
CD-ROM into the CD-ROM drive. For example, do one of the following:

• On the DFM 1.1 system, insert the DFM 1.2 CD-ROM

• On the DFM 1.1 system, insert the DFM 1.2 Updated for Common Services 
Version 2.2 CD-ROM

• On the DFM 1.2 system, insert the DFM 1.2 Updated for Common Services 
Version 2.2 CD-ROM.

The installer window appears, asking you if you want to install DFM.

Step 2 Click Cancel.

Step 3 From a DOS command prompt, stop the CiscoWorks daemon manager:

Z:\> net stop crmdmgtd

Step 4 If desired, export your CD One information. Refer to Installation and Setup Guide 
for CD One on Windows, or Installation and Setup Guide for CiscoWorks 
Common Services (Includes CiscoView) on Windows.
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Step 5 Run the export script, which is on the DFM upgrade CD ROM drive under the 
disk1 directory, from the top-level directory:

Z:\> cd \
Z:\> perl export_dfm.pl

Step 6 Copy all files and directories in NMSROOT\rigel to an identical location on the 
remote machine.

Caution The DFM upgrade NMSROOT\rigel\scripts directory contains a file 
that may not be in the local NMSROOT\rigel\scripts directory. This file 
is called import_userinfo.pl. Therefore, do not do a simple directory 
copy or you will lose this file.

Caution Be sure to copy the files to the same directory path (NMSROOT\rigel). 
Copy all files, not just the files and directories under the dfm directory, 
because the import script needs files that are not stored under the dfm 
directory.

For example, you could do one of the following:

• Map the source drive to the destination drive, and copy the files.

• Copy the files to disk or tape and transfer the files to the remote machine.

Step 7 On the local DFM machine, restart the CiscoWorks daemon manager:

Z:\> net start crmdmgtd

Step 8 On the remote (upgraded) DFM machine, stop the CiscoWorks daemon manager:

C:\> net stop crmdmgtd

Step 9 If desired, import your CD One information. Refer to Installation and Setup 
Guide for CD One on Windows, or Installation and Setup Guide for CiscoWorks 
Common Services (Includes CiscoView) on Windows.
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Step 10 Run the import script, where NMSROOT is the default installation directory 
(normally C:\Program Files\CSCOpx):

C:\> cd NMSROOT\rigel\scripts
C:\> perl import_dfm.pl

The import script checks the space requirements, ensures that the daemon 
manager is stopped, and displays the following prompt:

Importing will cause all the files to be overwritten.
Are you sure you want to import (Y/N)?

Step 11 Enter Y and press Return. 

Step 12 Restart the CiscoWorks daemon manager:

C:\> net start crmdmgtd

Step 13 Rediscover the devices in your DFM inventory by selecting 
Inventory > Inventory Collect All.

If any errors occurred during the upgrade, check the installation log in the root 
directory on the drive where the operating system is installed. Each installation 
creates a new log file. (For example, the CiscoWorks CD One installation might 
create C:\cw2000_in001.log, the DFM installation might create 
C:\cw2000_in002.log, and so forth.) The Technical Assistance Center (TAC) 
might ask you to send them the installation log. Also check import log, 
NMSROOT\rigel\manifest\dfm\import_dfm.log (where NMSROOT is the default 
installation directory, normally C:\Program Files\CSCOpx).
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The following sections describe how to reinstall DFM on the Windows operating 
system:

• Reinstalling DFM 1.2, page 2-27

• Reinstalling DFM 1.2 Updated for Common Services Version 2.2, page 2-33

Reinstalling DFM 1.2

Step 1 If HP OpenView is installed and operational, make sure it has been stopped (or 
the installation will take significantly longer).

Step 2 Close all open or active programs. Do not run other programs during the 
reinstallation process.

Step 3 As the local administrator, log on to the machine on which you will install the 
DFM software, and insert the DFM CD-ROM into the CD-ROM drive. The 
installer window appears, asking you if you want to reinstall DFM.

Note If the CD-ROM is already in the CD-ROM drive and you stopped the 
reinstallation process to close programs or if Autostart is disabled, click 
Setup.exe from the top directory of your CD-ROM to restart the process.

Step 4 Click Install. The Welcome window appears.

Step 5 Click Next to continue. The Setup Type dialog box appears.

Step 6 Select Custom to select the components to reinstall. The Select Components 
dialog box appears. (For more information on reinstallation components, refer to 
Table 1-1 on page 1-2.)
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Step 7 Select the component you want to reinstall and click Next. The Start Copying 
Files window appears. 

Step 8 Click Next.

Step 9 If you reinstalled only the HPOV-NetView Adapter or the RME Adapter, you are 
prompted to enter the name of the machine running the DFM Broker. Enter the 
name of the host (the default is localhost).

Note Make sure the machine running the DfmBroker is registered with DNS.

Step 10 Click Next.

Step 11 The Requirements Verification dialog box displays the results of the requirements 
check and advises whether the reinstallation can continue. One of the following 
should then occur:

• If minimum requirements are met, click OK. The Setup screen appears, 
displaying reinstallation progress while files are copied. The Setup Complete 
dialog box appears.

• If recommended requirements are not met, an error message appears. To 
continue the reinstallation, click OK.

If DFM detects another application using port 162, DFM displays the following 
message:

WARNING: Installation has detected port 162 in use. DFM is set to use 
port 9000 for receiving SNMP traps.

Step 12 If you see this message, after the installation completes, you must configure the 
SNMP Trap Adapter to use a different UDP port, such as port 9000. (Refer to the 
“Configuring the SNMP Trap Adapter” section on page 3-3.)
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Step 13 A dialog box appears, asking if you want to connect this instance of DFM with 
VHM 1.0. Do one of the following:

• If you will be using a remote version of VHM 1.0 with DFM, click Yes.

The reinstallation program copies the files to the directory in which DFM was 
originally installed. The Restart window appears.

Proceed to Step 16.

• If you will not be using a remote version of VHM 1.0 with DFM, click No. 
Proceed to Step 14.

Note You must give the same answer to this question when you install adapters. 
If you answer No and provide a DFM username and password, you must 
provide the same username and password

Step 14 The Setup window appears. In the username field, enter the DFM username. In 
the password field, enter the DFM password. 

Note You can change your username and password. Refer to the User Guide for 
Device Fault Manager, available from the online help, for more 
information.

Step 15 Click Next. The reinstallation program copies the files to the directory in which 
DFM was originally installed. The Restart window appears.

Step 16 Remove the DFM CD-ROM from the drive, and store the CD-ROM in a secure, 
climate-controlled area for safekeeping.

Step 17 Click Finish to reboot the machine.
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Step 18 Specify the clients that are allowed to connect to the DFM server. (DFM provides 
this fine-grain control as an additional security feature.)

a. Unregister the daemons with the daemon manager:

– For DFM notification adapters:

# NMSROOT\bin\pdcmd.exe -u DfmFileNotifier
# NMSROOT\bin\pdcmd.exe -u DfmTrapNotifier
# NMSROOT\bin\pdcmd.exe -u DfmMailNotifier

– For DfmServer:

# NMSROOT\bin\pdcmd.exe -u DfmServer

– For DfmBroker:

# NMSROOT\bin\pdcmd.exe -u DfmBroker

b. Decide which hosts you want to specify using the --accept option with 
arguments shown in Table 2-3.

Note If you specify registration options using pdcmd, you must re-run your 
command whenever the daemon manager restarts.

Table 2-3 Arguments to the --accept Option

Argument Description

host1,host2,... Allow only host1,host2,... to connect to the server. If the 
hostname is registered with DNS, you can specify the client 
by hostname. Otherwise, specify explicit IP addresses in a 
comma-separated list. Hostnames are resolved to one or more 
IP addresses, which are then used (the server does not use 
reverse lookups to determine the name of a connecting host).

Note If you specify the clients as hostnames, be sure the 
hostname is registered with DNS, especially if you 
are using DHCP.

=any Allow all incoming connections (default).
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For example, the following command fragment would allow connections only 
from hosts lucy and ethel:

--accept=lucy,ethel

Note To allow connections from processes running on the same host, 
specify the host's name—do not use “localhost.” This is because 
connections made using the DFM Broker will appear to come from 
the DFM Broker’s host. Only connections that explicitly specify 
“localhost” as the target address will appear to come from localhost. 
Such target addresses may result in configurations that forward 
incoming connections (such as through software that provides an 
encrypted tunnel).

c. Re-register the daemons with the daemon manager, specifying the clients that 
can connect to the broker and server (in this example, the DFM broker port is 
9002 and lucy and ethel are the clients):

– For DfmBroker (the following command is one line):

# NMSROOT\bin\pdcmd.exe -r DfmBroker -e NMSROOT\objects\smarts\bin\brstart.exe -f 
"--output --port=9002 --accept=lucy,ethel 
--restore=NMSROOT\objects\smarts\conf\broker.rps"

– For DfmServer (the following command is one line):

# NMSROOT\bin\pdcmd.exe -r DfmServer -e NMSROOT\objects\smarts\bin\sm_server.exe -d 
DfmBroker -f "--bootstrap=DFM_bootstrap.conf --accept=lucy,ethel --output --name=DFM"

– For DFM notification adapters (the following commands are each one 
line, and will register the adapter processes to automatically start upon 
reboot):

# NMSROOT\bin\pdcmd.exe -r DfmFileNotifier -d DfmServer -e 
NMSROOT\objects\smarts\bin\sm_notify.exe -f "--adapter=filelog --output=sm_file_notifier"

# NMSROOT\bin\pdcmd.exe -r DfmTrapNotifier -d DfmServer -e 
NMSROOT\objects\smarts\bin\sm_notify.exe -f "--adapter=trap --output=sm_trap_notifier"

# NMSROOT\bin\pdcmd.exe -r DfmMailNotifier -d DfmServer -e 
NMSROOT\objects\smarts\bin\sm_notify.exe -f “--adapter=mail --output=sm_mail_notifier"
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If you do not want the daemons to start after a reboot, add the -n option 
to the end of the command, as in this File Notifier Adapter example:

# NMSROOT\bin\pdcmd.exe -r DfmFileNotifier -d DfmServer -e 
NMSROOT\objects\smarts\bin\sm_notify.exe -f "--adapter=filelog --output=sm_file_notifier" 
-n

d. Make sure that the client names and current IP addresses are registered with 
DNS if one or both of the following apply:

– You are running DHCP 

– You specified the clients with hostnames

Step 19 To verify that the DfmServer process is running, log on to the CiscoWorks desktop 
as the administrator and select Server Configuration >
Administration >Process Management> Process Status.

Note If your client does not have the Java plug-in, you will receive a message 
asking if you want to install it. The plug-in is required for DFM 1.2.

Step 20 To use DFM, select Device Fault Manager from the CiscoWorks navigation tree.

Step 21 Rediscover the devices in your DFM inventory by opening the Administration 
Console and selecting Inventory > Inventory Collect All.

Note Depending on the number of managed devices, rediscovering the entire 
DFM inventory could take several hours.

Step 22 If you used remote adapters with Device Fault Manager 1.1, perform these steps:

a. Make sure the machine running the DfmBroker is registered with DNS.

b. Upgrade all remote adapters as described in the “Installing and Upgrading 
Adapters” section on page 2-38.

When HP OpenView or NetView is restarted, CiscoWorks automatically 
configures the adapters to forward SNMP traps from HP OpenView or NetView 
to DFM. If you install HP OpenView or NetView later, you will have to either 
configure the SNMP Trap Adapter to use another port (as described in the 
“Configuring the SNMP Trap Adapter” section on page 3-3), or reinstall DFM.
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If Essentials is presently (or subsequently) installed locally, CiscoWorks 
automatically configures the adapters to forward Essentials inventory device 
information to DFM. To do this with remote versions of HP OpenView, NetView, 
or Essentials, you must install the remote adapters as described in the “Installing 
and Upgrading Adapters” section on page 2-38.

If you had any errors during reinstallation, check the installation log in the root 
directory on the drive (For example, the CiscoWorks installation might create 
C:\cw2000_in001.log, the DFM installation might create C:\cw2000_in002.log, 
and so forth.) The Technical Assistance Center (TAC) might ask you to send them 
the installation log.

Reinstalling DFM 1.2 Updated for Common Services Version 2.2

Step 1 If HP OpenView is installed and operational, make sure it has been stopped (or 
the installation will take significantly longer).

Step 2 Close all open or active programs. Do not run other programs during the 
reinstallation process.

Step 3 As the local administrator, log on to the machine on which you will install the 
DFM software, and insert the DFM CD-ROM into the CD-ROM drive. The 
installer window appears, asking you if you want to reinstall DFM.

Note If the CD-ROM is already in the CD-ROM drive and you stopped the 
reinstallation process to close programs or if Autostart is disabled, click 
Setup.exe from the top directory of your CD-ROM to restart the process.

Step 4 Click Install. The Welcome window appears.

Step 5 Click Next to continue. The Software License Agreement window appears. 

Step 6 To accept the agreement and continue the reinstallation, click Yes.
2-33
Installation and Setup Guide for Device Fault Manager on Windows

78-14965-01



 

Chapter 2      Installing Device Fault Manager
Reinstalling Device Fault Manager
Step 7 If your system contains installed IDUs that were released after DFM 1.2.3 (such 
as DFM 1.2 IDU 1.2.4), one of the following will happen:

• If you did enable DFM when you first installed it, a window opens displaying 
the following message:

A newer version of DFM is already running on your system.

Because the installation would provide no new functionality, the installation 
program exits, and your existing device support is preserved.

• If you did not enable DFM when you first installed it, the Enable DFM 
window opens, displaying the following message:

The installation program has detected a newer version of DFM 
already on your system. The newer version is disabled. Do you want 
to enable it?
Click “Yes” to enable the newer version of DFM.
Click “No” to abort the installation.

Do one of the following:

– To enable DFM, click Yes. Because continuing the installation would add 
no new functionality, further DFM installation is not required, and the 
installation program exits. To re-establish settings that were lost when 
CiscoWorks Common Services 2.2 was installed (and DFM was 
disabled), proceed to Step 15 in the “Performing a New Installation of 
DFM 1.2” section on page 2-2.

– To keep DFM disabled, select No. DFM remains disabled, and the 
installation program exits.
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Step 8 The Setup Type dialog box appears. Select Custom to select the components to 
reinstall. The Select Components dialog box appears.

The system displays these options (the choices may vary, depending on your 
configuration):

CiscoWorks Device Fault Manager (reinstall)
Device Fault Manager Incremental Device Support (reinstall)

(For more information on reinstallation components, refer to Table 1-1 on 
page 1-2.)

Step 9 Select the component you want to reinstall and click Next. The installation 
program checks dependencies and system requirements.

Step 10 The System Requirements dialog box appears, displays the results of the 
requirements check, and advises whether the installation can continue. One of the 
following should then occur: 

• If minimum requirements are met, click Next. 

• If recommended requirements are not met, an error message appears. To 
continue the reinstallation, click Next.

Step 11 If you reinstalled only the HPOV-NetView Adapter or the RME Adapter, you are 
prompted to enter the name of the machine running the DFM Broker. Enter the 
name of the host (the default is localhost).

Note Make sure the machine running the DfmBroker is registered with DNS.

Step 12 Click Next.

Step 13 The Summary dialog box displays your selected settings. Click Next.
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Step 14 The Setup window appears, displaying installation progress while files are 
copied. 

If DFM detects another application using port 162, DFM displays the following 
message:

WARNING: Installation has detected port 162 in use. DFM is set to use 
port 9000 for receiving SNMP traps.

If you see this message, after the installation completes, you must configure the 
SNMP Trap Adapter to use a different UDP port, such as port 9000. (Refer to the 
“Configuring the SNMP Trap Adapter” section on page 3-3.)

Step 15 To finish reinstalling DFM 1.2 Updated for Common Services Version 2.2, follow 
Step 13 through Step 22 in the “Reinstalling DFM 1.2” section on page 2-27.
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Removing Device Fault Manager
This section explains the steps for removing DFM 1.2 or DFM 1.2 Updated for 
Common Services Version 2.2 from Windows systems.

Caution You must use the CiscoWorks uninstallation program to remove DFM from your 
system. If you try to remove the files and programs manually, you can seriously 
damage your system.

Step 1 As the local administrator, log on to the system on which DFM is installed, and 
select Start> Programs > CiscoWorks >Uninstall CiscoWorks to start the 
uninstallation process. The Uninstallation window appears, and the system 
displays these options (the choices may vary, depending on your configuration):

CiscoWorks Common Services
CiscoView
Device Fault Manager

Step 2 Deselect everything except Device Fault Manager and click Next. A dialog box 
listing the components selected for removal appears. (Removing DFM also 
removes DFM incremental device support. For more information on 
uninstallation components, refer to Table 1-1 on page 1-2.)

Step 3 Click Next. Messages appear, showing the progress of the uninstallation, and the 
uninstallation completes.
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Installing and Upgrading Adapters
Several software adapters link DFM with its environment. For the purposes of 
installation, this section classifies these adapters as local or remote, depending on 
whether or not they are installed on the same host as DFM. Detailed information 
on the adapters is provided in the User Guide for Device Fault Manager (available 
from online help).

Types of Adapters: Local and Remote
Local adapters are installed for forwarding traps or synchronizing information 
with NMSs running on the DFM host; remote adapters do the same, but on remote 
hosts not running DFM.

Local Adapters

When you install DFM locally, all adapters are installed. The local adapters 
include:

• File Notifier Adapter—Logs alarms detected by the DFM server and forwards 
them to a file. A file is the only valid recipient for this adapter. This adapter 
is normally used to create a historical file containing all alarms generated by 
DFM.

• Trap Notifier Adapter—Converts DFM alarms into SNMP trap messages and 
forwards the traps to recipients. You can specify recipients, such as NMSs or 
other domain managers, using an IP address or a system name. This adapter 
is normally used to send DFM alarms to another application for additional 
processing or display.

• Mail Notifier Adapter—Using SMTP, send mail notifications to recipients. 
As with the Trap Notifier Adapter, you can specify recipients—in this case, 
an email address. This adapter is normally used to generate asynchronous 
email notifications (for example, to an epage or an email address) when one 
or more alarm conditions occur.

• SNMP Trap Adapter—Listens on a user-specified port for traps sent to DFM 
from managed devices, and forwards traps to specified destinations. This 
adapter provides a generic method for integrating DFM with other NMS 
applications. The SNMP Trap Adapter is normally used to allow DFM to 
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coexist with another trap-receiving application (such as an NMS) on the same 
server; have an NMS forward traps to DFM for processing; or have DFM 
listen for traps on devices and forward the traps to an NMS that does not 
support trap forwarding. Basic steps for configuring this adapter are provided 
in Chapter 3, “Getting Started.”

• HPOV-NetView Adapter—Forwards traps that managed devices send to a 
local HP OpenView or NetView NMS to DFM. This adapter is normally used 
when you want DFM to monitor faults on devices managed by a local version 
of HP OpenView or NetView. (For information on supported HP OpenView 
and NetView versions, refer to the “Supported NMS Integration” section on 
page 1-21.)

• RME Adapter—Synchronizes the list of managed devices in a local 
Essentials inventory with a DFM inventory. This adapter is normally used 
when you want DFM to monitor faults on devices managed by a local version 
of Essentials. (For information on supported Essentials versions, refer to the 
“Supported NMS Environments for Device Import” section on page 1-21.)

Remote Adapters

In addition to using the following adapters locally, you can install them remotely 
(on hosts not running DFM) to exchange remote device information with DFM:

• RME Adapter—Synchronizes the list of managed devices in a remote 
Essentials inventory with a local DFM inventory. This adapter is normally 
used when you want a local DFM to monitor faults on devices managed by a 
remote version of Essentials. (For information on supported Essentials 
versions, refer to the “Supported NMS Environments for Device Import” 
section on page 1-21.)

• HPOV-NetView Adapter—Forwards traps that managed devices send to a 
remote HP OpenView or NetView NMS to DFM. This adapter is normally 
used when you want a local DFM to monitor faults on devices managed by a 
remote version of HP OpenView or NetView. (For information on supported 
HP OpenView and NetView versions, refer to the “Supported NMS 
Integration” section on page 1-21.)

Note NetView must be installed on the same drive as DFM (for local 
integration) or on the same drive as the HPOV-NetView Adapter (for 
remote integration).
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Configuring and Starting Adapters
Table 2-4 summarizes which adapters you must configure, whether you can use 
the GUI or command line to configure the adapter, and whether you must 
manually start the adapter. Additional information on configuring and starting 
adapters is provided in the User Guide for Device Fault Manager (available from 
online help).

Note Whenever you configure any adapter using the command line, you must manually 
stop and restart the adapter. Adapters configured with the DFM administration 
menus do not need to be stopped and restarted. 

Table 2-4 Configuring and Starting Adapters

Adapter Type
and Name

Must Be 
Configured 
Before Use

Can Be Configured Using...
Automatically Starts with 
CiscoWorksGUI CLI

Notification Adapters

File Notifier

Trap Notifier

Mail Notifier

Yes Yes Yes No

Yes Yes Yes No

Yes Yes Yes No

Event Adapters

HPOV-NetView No No Yes Yes, if HP OpenView or 
NetView is installed on the 
same machine as the adapter

Special Adapters

SNMP Trap

RME Adapter

Yes Yes Yes Yes

No N/A, but can be 
started using 
the GUI

N/A Yes, if Essentials is installed on 
the same machine as the adapter
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Installing or Upgrading the HPOV-NetView Adapter on a Remote 
Host

This section describes how to install or upgrade the HPOV-NetView Adapter on a 
remote host so the adapter can exchange information with DFM on a local host. 
You can install or upgrade the HPOV-NetView Adapter on remote hosts regardless 
of whether CiscoWorks is present. You can also use this procedure to reinstall the 
HPOV-NetView Adapter on a machine running CiscoWorks; reinstallation of the 
HPOV-NetView Adapter is supported only on machines running CiscoWorks.

If you upgrade a local version of DFM 1.1, you must also upgrade all remote 
adapters. You do not need to upgrade DFM 1.2 adapters if you are upgrading to 
DFM 1.2 Updated for Common Services Version 2.2.

Note NetView must be installed on the same drive as DFM (for local integration) or on 
the same drive as the HPOV-NetView Adapter (for remote integration).

Note To upgrade a remote HPOV-NetView Adapter, you must first remove the old 
adapter and then install the new version.

Note If the DFM broker is moved—for example, if DFM is moved to a different 
machine, or you want to use a different instance of DFM—you must reinstall the 
remote adapters.
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Installing or Upgrading the HPOV-NetView Adapter on a Remote Host Running 
CiscoWorks

Use this procedure to do the following:

• Install a new HPOV-NetView Adapter on a remote host running CiscoWorks, 
or 

• Upgrade a DFM 1.1 version of the HPOV-NetView Adapter on a remote host 
running CiscoWorks

You do not need to upgrade DFM 1.2 adapters if you are upgrading to DFM 1.2 
Updated for Common Services Version 2.2.

Step 1 If you want to upgrade a DFM 1.1 version of the HPOV-NetView Adapter, remove 
the adapter as described in the “Removing the HPOV-NetView Adapter from a 
Remote Host Running CiscoWorks” section on page 2-49.

Step 2 As the local administrator, log on to the machine on which you will install the 
HPOV-NetView Adapter, and insert the DFM CD-ROM into the CD-ROM drive. 
The installer window appears, asking you if you want to install DFM. 
(Alternatively, you can install the adapter using DFM 1.2 Patch/IDU 1.2.7 or 
later, and proceed to Step 3.)

Note If the CD-ROM is already in the CD-ROM drive and you stopped the 
installation process to close programs or if Autostart is disabled, click 
Setup.exe to restart the process.

Note To use the HPOV-NetView Adapter with NetView, be sure to install the adapter 
on the same drive as NetView.

Step 3 Click Install. The Welcome window appears.

Step 4 Click Next.

Step 5 If you are upgrading your DFM 1.1 adapter to DFM 1.2 Updated for Common 
Services Version 2.2, the Software License Agreement window appears. To accept 
the agreement and continue the installation, click Yes. 

Step 6 The Setup Type dialog box appears. Select Custom to select a component to 
install and click Next. The Select Components dialog box appears.
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Step 7 Select Device Fault Manager HPOV-NetView adapters and click Next. 
HP OpenView and NetView are stopped. The installation program checks 
dependencies and system requirements.

Step 8 Click Next. HP OpenView and NetView are stopped. The Requirements 
Verification dialog box displays the results of the requirements check and advises 
whether installation can continue. 

Step 9 When prompted, enter the machine name or IP address of the machine on which 
the DfmBroker is running (this is normally the machine that is running DFM). 

Note Do not use the default, localhost. Also, make sure the machine running the 
DfmBroker is registered with DNS.

Step 10 A dialog box appears, asking if you want to connect this instance of DFM with 
VHM 1.0. 

Note You must give the same answer to this question that you gave when 
installing DFM. If you answered No to this question when installing 
DFM, you must provide the same username and password pair that you 
provided for DFM.

Do one of the following:

• If you will be using a remote version of VHM 1.0 with DFM, click Yes.

HP OpenView and NetView are stopped. The Requirements Verification 
dialog box displays the results of the requirements check and advises whether 
installation can continue

Proceed to Step 12.

• If you will not be using a remote version of VHM 1.0 with DFM, click No. 
Proceed to Step 11.

Step 11 The Setup window appears. In the username field, enter the DFM username. In 
the password field, enter the DFM password. 

Note You can change your username and password. Refer to the User Guide for 
Device Fault Manager, available from the online help, for more 
information.
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Step 12 Click OK. The installation program copies the files to the directory in which CD 
One was installed.

Step 13 Remove the DFM CD-ROM from the drive.

Installing or Upgrading the HPOV-NetView Adapter on a Remote Host Not Running 
CiscoWorks

Use this procedure to do the following:

• Install a new HPOV-NetView Adapter on a remote host that is not running 
CiscoWorks, or 

• Upgrade a DFM 1.1 version of the HPOV-NetView Adapter on a remote host 
that is not running CiscoWorks

If you try to run the DFMadapter.exe script on a host that is running CiscoWorks 
or DFM, you will receive an error message and the installation will abort.

You do not need to upgrade DFM 1.2 adapters if you are upgrading from DFM 1.2 
to DFM 1.2 Updated for Common Services Version 2.2.

Note The DFMadapter.exe script does not support reinstallation.

Step 1 Verify that you have 31 MB of space for installing the adapter.

Step 2 If you want to upgrade a 1.1 version of the HPOV-NetView Adapter, remove the 
adapter as described in the “Removing the HPOV-NetView Adapter from a 
Remote Host Not Running CiscoWorks” section on page 2-50.

Step 3 From a temporary directory, use ftp to copy the binary file 
NMSROOT\htdocs\rdist\dfm\DFMadapter.exe from the running DFM. In the 
following commands, dfm-host is where DFM is installed, and NMSROOT is the 
DFM installation directory (normally C:\Program Files\CSCOpx):

# cd \Temp
# ftp dfm-host
User (dfm-host:(none)): login
Password: password
ftp> cd NMSROOT\htdocs\rdist\dfm
ftp> get DFMadapter.exe
ftp> quit
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Step 4 Double-click DFMadapter.exe. The Choose Destination Location window 
appears.

Step 5 In the Select Destination Folder field, select C:\DFM and click Next. The Setup 
Window appears.

Step 6 Enter the machine name or IP address of the machine on which the DfmBroker is 
running (normally the machine that is running DFM). 

Note Do not use the default, localhost. Also make sure the machine running the 
DfmBroker is registered with DNS.

Step 7 A dialog box appears, asking if you want to connect this instance of DFM with 
VHM 1.0. 

Note You must give the same answer to this question that you gave when 
installing DFM. If you answered No to this question when installing 
DFM, you must provide the same username and password pair that you 
provided for DFM.

Do one of the following:

• If you will be using a remote version of VHM 1.0 with DFM, click Yes.

The adapter is installed (or upgraded), and HP OpenView and NetView are 
stopped.

Proceed to Step 10.

• If you will not be using a remote version of VHM 1.0 with DFM, click No. 
Proceed to Step 8.

Step 8 The Setup window appears. In the username field, enter the DFM username. In 
the password field, enter the DFM password. 

Note You can change your username and password. Refer to the User Guide for 
Device Fault Manager, available from the online help, for more 
information.

Step 9 Click Next. The adapter is installed (or upgraded), and HP OpenView and 
NetView are stopped.
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Step 10 Click Finish. The Restarting Windows dialog box appears.

Step 11 Select Yes to confirm that you want to reboot, and click OK.

Step 12 Restart HP OpenView or NetView to activate the adapter (using the ovstart or 
nvstart command).

CiscoWorks automatically configures the remote adapters to foward SNMP traps 
from HP OpenView and NetView to DFM.

Installing or Upgrading the RME Adapter on a Remote Host
This section describes how to install or upgrade the RME Adapter on a remote 
host so the adapter can exchange information with DFM on a local host. You can 
also use this procedure to reinstall the RME Adapter. 

Installing or Upgrading the RME Adapter on a Remote DFM Host

Use this procedure to do the following:

• Install a new RME Adapter on a remote host running CiscoWorks, or 

• Upgrade a DFM 1.1 version of the RME Adapter on a remote host running 
CiscoWorks

You do not need to upgrade DFM 1.2 adapters if you are upgrading from DFM 1.2 
to DFM 1.2 Updated for Common Services Version 2.2.

Note If the DFM broker is moved—for example, if DFM is moved to a different 
machine, or you want to use a different instance of DFM—you must reinstall the 
remote adapters.
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Step 1 As the local administrator, log on to the machine on which you will install the 
HPOV-NetView Adapter, and insert the DFM CD-ROM into the CD-ROM drive. 
(Alternatively, you can install the adapter using DFM 1.2 Patch/IDU 1.2.7 or 
later.) The installer window appears, asking you if you want to install DFM.

Note If the CD-ROM is already in the CD-ROM drive and you stopped the 
installation process to close programs or if Autostart is disabled, click 
Setup.exe to restart the process.

Step 2 Click Install. The Welcome window appears.

Step 3 Click Next.

Step 4 If you are upgrading your DFM 1.1 adapter to DFM 1.2 Updated for Common 
Services Version 2.2, the Software License Agreement window appears. To accept 
the agreement and continue the installation, click Yes. 

Step 5 The Setup Type dialog box appears. Select Custom to select a component to 
install and click Next. The Select Components dialog box appears.

Step 6 Select Device Fault Manager RME Adapter and click Next. The Start Copying 
Files dialog box appears.

Step 7 Click Next. The Requirements Verification dialog box displays the results of the 
requirements check and advises whether installation can continue. 

Step 8 Click OK. The installation program copies the files to the CiscoWorks default 
installation directory C:\Program Files\CSCOpx (NMSROOT). The Enter 
Information window appears, asking you for the name of the machine running the 
DFM Broker.

Step 9 Enter the machine name or IP address of the machine on which the DfmBroker is 
running (this is normally the machine that is running DFM).

Note Do not use the default, localhost. Also make sure the machine running the 
DfmBroker is registered with DNS.
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Step 10 A dialog box appears, asking if you want to connect this instance of DFM with 
VHM 1.0. 

Note You must give the same answer to this question that you gave when 
installing DFM. If you answered No to this question when installing 
DFM, you must provide the same username and password pair that you 
provided for DFM.

Do one of the following:

• If you will be using a remote version of VHM 1.0 with DFM, click Yes.

The Restart Windows dialog box appears.

Proceed to Step 13.

• If you will not be using a remote version of VHM 1.0 with DFM, click No. 
Proceed to Step 11.

Step 11 The Setup window appears. In the username field, enter the DFM username. In 
the password field, enter the DFM password. 

Note You can change your username and password. Refer to the User Guide for 
Device Fault Manager, available from the online help, for more 
information.

Step 12 Click Next. The Restart Windows dialog box appears. 

Step 13 Select Yes and click OK to reboot the machine.

Step 14 Remove the DFM CD-ROM from the drive.

After Essentials is installed, CiscoWorks automatically configures the remote 
adapters to forward Essentials inventory device information to DFM.

If you had any errors during installation (or upgrade), check the installation log in 
the root directory on the drive. (For example, the CiscoWorks installation might 
create C:\cw2000_in001.log, the DFM installation might create 
C:\cw2000_in002.log, and so forth.) The Technical Assistance Center (TAC) 
might ask you to send them the installation log.
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Removing Adapters
When you remove a local version of DFM, all local adapters are also removed. To 
remove a remote adapter, follow the instructions in this section.

Removing the HPOV-NetView Adapter from a Remote Host
You can remove the HPOV-NetView Adapter from remote host machines with or 
without installed CiscoWorks products.

Caution You must use the CiscoWorks uninstallation program to remove the adapters from 
your system. If you try to remove the files and programs manually, you can 
seriously damage your system.

Removing the HPOV-NetView Adapter from a Remote Host Running CiscoWorks

Use this procedure to remove the HPOV-NetView Adapter from a remote host that 
is running CiscoWorks.

Step 1 As the local administrator, log on to the system on which the remote 
HPOV-NetView Adapter is installed, and select 
Start> Programs > CiscoWorks> Uninstall CiscoWorks to start the 
uninstallation process. The Uninstall window appears, displaying a list of the 
installed applications.

Step 2 Deselect everything except Device Fault Manager HPOV-NetView Adapters.

Step 3 Click Next. A dialog box listing the components selected for removal appears.

Step 4 Click Next to begin removing the HPOV-NetView Adapter. Messages appear, 
showing the progress of the uninstallation, and the uninstallation completes.

Step 5 Click OK.
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If you had any errors during uninstallation, check the installation log in the root 
directory on the drive. (For example, the CiscoWorks installation might create 
C:\cw2000_in001.log, the DFM installation might create C:\cw2000_in002.log, 
and so forth.) The Technical Assistance Center (TAC) might ask you to send them 
the installation log.

Removing the HPOV-NetView Adapter from a Remote Host Not Running 
CiscoWorks

Use this procedure to remove the HPOV-NetView Adapter from a remote host that 
does not contain CiscoWorks. If you try to run the DFMadapter.exe on a host that 
is running CiscoWorks or DFM, you will receive an error message and the 
uninstallation will abort.

Step 1 From a temporary directory, use ftp to copy the 
NMSROOT\htdocs\rdist\dfm\DFMadapter.exe binary file from the running DFM. 
In the following commands, dfm-host is where DFM is installed, and NMSROOT 
is the DFM installation directory (normally
C:\Program Files\CSCOpx):

# cd \Temp
# ftp dfm-host
User (dfm-host:(none)):login
Password: password
ftp> cd NMSROOT\htdocs\rdist\dfm
ftp> get DFMadapter.exe
ftp> quit

Step 2 Double-click DFMadapter.exe. The Confirm File Deletion window appears.

Step 3 Click OK. The adapter is removed, and HP OpenView and NetView are stopped 
and restarted. The Setup window appears.

Step 4 Click Finish.
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Removing the RME Adapter from a Remote Host
This section describes how to remove the RME Adapter from a remote host.

Caution You must use the CiscoWorks uninstallation program to remove the RME Adapter 
from your system. If you try to remove the files and programs manually, you can 
seriously damage your system.

Step 1 As the local administrator, log on to the system on which the RME Adapter is 
installed, and select Start> Programs >CiscoWorks > Uninstall CiscoWorks to 
start the uninstallation process. The Uninstall window appears, displaying a list 
of the installed applications.

Step 2 Deselect everything except Device Fault Manager RME adapter.

Step 3 Click Next. The Uninstallation window lists the components selected for removal.

Step 4 Click Next to begin removing the RME Adapter. Messages appear, showing the 
progress of the uninstallation, and the uninstallation completes.

If you had any errors during installation, check the installation log in the root 
directory on the drive. (For example, the CiscoWorks installation might create 
C:\cw2000_in001.log, the DFM installation might create C:\cw2000_in002.log, 
and so forth.) The Technical Assistance Center (TAC) might ask you to send them 
the installation log.
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C H A P T E R 3

Getting Started

This section provides a minimum number of steps for setting up Device Fault 
Manager (DFM) and viewing diagnostic results. It is intended to help you to start 
using DFM immediately.

Note Within DFM are three consoles: the Monitoring Console, the Administration 
Console, and the Polling and Thresholds Console. The consoles are described in 
detail in the User Guide for Device Fault Manager (available from online help).

To start using DFM, you will want to perform most of the steps in these sections:

• Enabling Devices to Send Traps to DFM, page 3-2

• Enabling DFM to Send Traps to NMSs, page 3-2

• Preparing a Seed File, page 3-8

• Accessing Device Fault Manager, page 3-10

• Importing Devices from a Seed File, page 3-11

• Opening the DFM Administration Console, page 3-12

• Opening the DFM Polling and Thresholds Console, page 3-12

• Checking Default Settings, page 3-13
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• Accessing the Device Inventory, page 3-13

• Probing the DFM Inventory, page 3-14

• Opening the DFM Monitoring Console, page 3-16

• Closing the DFM Monitoring Console, page 3-17

Enabling Devices to Send Traps to DFM
Make sure your devices are enabled to send traps to DFM by using the command 
line or GUI interface appropriate for your device. For example, if you are using 
Essentials, you can use the NetConfig application.

• For information on enabling traps on IOS-based devices, use the
snmp-server enable traps command. Refer to the appropriate command 
reference guide on cisco.com:

http://www.cisco.com/univercd/cc/td/doc/product/software/index.htm

• For information on enabling traps on Catalyst devices (which use the Catalyst 
operating system), use the set snmp trap command. Refer to the appropriate 
command reference guide on cisco.com:

http://www.cisco.com/univercd/cc/td/doc/product/lan/index.htm

Enabling DFM to Send Traps to NMSs
If you want DFM to integrate with other NMSs, you must enable trap forwarding 
in DFM by performing the tasks outlined in these sections:

1. Configuring the SNMP Trap Adapter, page 3-3

2. Integrating the SNMP Trap Adapter with Other Trap Daemons, page 3-5

For more information on configuring adapters, refer to the User Guide for Device 
Fault Manager (available from online help).
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Configuring the SNMP Trap Adapter
The SNMP Trap Adapter listens for traps (from managed devices) on a 
user-specified port and forwards the traps to specified destinations, providing a 
generic method for integrating with other NMS applications. If another NMS is 
already listening for traps on the standard UDP trap port (162), you must 
configure this adapter to use another port, such as port 9000.

You can use the DFM administration menus to configure the SNMP Trap Adapter 
to both receive and forward SNMP traps.

Using the GUI to Configure the SNMP Trap Adapter to Receive Traps

To configure which port will be monitored for SNMP traps DFM receives from 
other NMSs:

Step 1 Make sure the devices and/or NMSs that are forwarding traps to DFM are 
configured to send them to the port defined in the adapter configuration file.

If another NMS is already listening for traps on the standard UDP trap port (162), 
you must configure this adapter to use another port, such as port 9000.

Step 2 Select Device Fault Manager >Administration> Trap Configuration > Trap 
Receiving.

Step 3 In the Listening Port field, enter the port number of the local host where the DFM 
server is running.

Step 4 Select the Restart DFM Server check box if you want to restart the server when 
you click OK. (You must restart the DFM server for your changes to take effect.)

Step 5 Click OK.
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This procedure does the following:

• Enables/disables the process and registers/unregisters the process with 
CiscoWorks. When the process is unregistered, you will no longer see it using 
Server Configuration > Administration > Process Management.

• Updates the SNMP Trap Adapter configuration file 
NMSROOT\objects\smarts\conf\trapd\trapd.conf.

• Saves SNMP Trap Adapter log information in the DFM domain manager log 
file NMSROOT\objects\smarts\logs\DFM.log

If you did not select the Restart DFM Server check box, you must do so manually 
to apply your changes. Use Server Configuration > Administration > Process 
Management. To further configure the adapter—for example, to specify how 
nonprintable characters are formatted—use the command line as described in the 
User Guide for Device Fault Manager (available from online help).

You may also need to complete one or more of the following steps:

• If your network devices are already sending traps to another management 
application, configure that application to forward traps to DFM.

• If your devices are already configured to send traps to port 162, and no other 
management application is using port 162, then you can configure DFM to 
listen on port 162 instead of port 9000.

• If your network devices are already sending traps to another NMS, but that 
NMS cannot forward traps, you should:

– Configure the devices to send traps to DFM.

– Configure DFM to forward the traps to the other NMS.

Using the GUI to Configure the SNMP Trap Adapter to Forward Traps

To have DFM send received traps to other NMSs:

Step 1 Select Device Fault Manager> Administration >Trap Configuration >Trap 
Forwarding.

Step 2 In the Forwarding field, select ON or OFF to enable or disable trap forwarding.

Step 3 If you want to add a recipient, in the Add Recipient field, enter the hostname and 
port number of the machine you want to forward traps to.
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Step 4 If you want to remove a recipient, select the recipient from the Remove Recipient 
field.

Step 5 Click OK.

Step 6 If you want to add or remove any other recipients, repeat the appropriate steps and 
click OK. Repeat these steps until you have added or removed all recipients.

Step 7 Select the Restart DFM Server check box if you want to restart the server when 
you click OK. (You must restart the DFM server for your changes to take effect.)

This procedure does the following:

• Enables/disables the process and registers/unregisters the process with 
CiscoWorks. When the process is unregistered, you will no longer see it using 
Server Configuration > Administration > Process Management.

• Updates the SNMP Trap Adapter configuration file 
NMSROOT\objects\smarts\conf\trapd\trapd.conf.

• Saves SNMP Trap Adapter log information in the DFM domain manager log 
file NMSROOT\objects\smarts\logs\DFM.log

If you did not select the Restart DFM Server check box, you must do so manually 
to apply your changes. Use Server Configuration > Administration > Process 
Management. To further configure the adapter—for example, to specify how 
nonprintable characters are formatted—use the command line as described in the 
User Guide for Device Fault Manager (available from online help).

Integrating the SNMP Trap Adapter with Other Trap Daemons
The SNMP Trap Adapter can receive traps on any port and forward them to a list 
of devices and ports. This flexibility enables it to easily work with other trap 
processing applications. The following sections describe possible scenarios for 
integrating the SNMP Trap Adapter with an existing network management system 
(NMS) platform.
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You may need to complete one or more of the following steps to configure the trap 
notifier adapter:

• Add the host where DFM is running to the list of trap destinations in your 
network devices. Specify port 9000 as the destination trap port. 

• If your network devices are already sending traps to another management 
application, configure that application to forward traps to DFM.

• If your devices are already configured to send traps to port 162, and no other 
management application is using port 162, then you can configure DFM to 
listen on port 162 instead of port 9000.

Scenario One

DFM and another NMS are installed on the same host. DFM can be configured to 
listen for traps on default port 162 and forward them to the NMS, which listens 
on a nonstandard port, such as port 9000.

The advantages of this approach:

• SNMP Trap Adapter provides a reliable trap reception, storage, and 
forwarding mechanism.

• Devices do not need to be reconfigured to send traps to another host or port.

• DFM and the NMS run on the same host.

Scenario Two

DFM and the NMS run on separate hosts. Network devices send traps to port 162 
of the host where DFM is running. DFM receives the traps and forwards them to 
the NMS.

The advantages of this approach:

• SNMP Trap Adapter provides a reliable trap reception, storage, and 
forwarding mechanism.

• NMS continues to receive traps on port 162.

• Network devices continue to send traps to port 162.
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Scenario Three

DFM and the NMS are installed on the same host. The SNMP Trap Adapter listens 
for traps on port 9000 and forwards them to the NMS on port 162.

The advantages of this approach:

• SNMP Trap Adapter provides a reliable trap reception, storage, and 
forwarding mechanism.

• No reconfiguration of the NMS is required; it continues to listen for traps on 
the default port 162.

• DFM and the NMS run on the same host.

Scenario Four

DFM and the NMS run on the same host. The NMS receives traps on port 162 and 
forwards them to the SNMP Trap Adapter, which listens for traps on a 
nonstandard port such as port 9000.

The advantages of this approach:

• No reconfiguration of the NMS is required.

• No reconfiguration of network devices is required.

• DFM and the NMS run on the same host.

• The SNMP Trap Adapter does not receive traps dropped by the NMS.

Scenario Five

DFM and the NMS run on separate hosts. The NMS receives traps on the default 
port of 162 and forwards them to port 162 on the host where DFM is running.

The advantages of this approach:

• No reconfiguration of the NMS is required.

• No reconfiguration of network devices is required.

• The SNMP Trap Adapter does not receive traps dropped by the NMS.
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Preparing a Seed File
When DFM is installed as a standalone product, the device inventory of the 
network must be imported into DFM from a text file called a seed file. The file 
can be created with any text editor. Subsequent updates to groups of managed 
devices can also be performed by way of a seed file. Individual devices can be 
added using the Add Agent option listed on the Inventory menu of the 
Administration Console.

A seed file lists top-level network devices such as hosts, routers, switches, and 
hubs. After the seed file is imported into DFM, DFM automatically discovers the 
internal structure of the devices. For example, you need only provide the name or 
IP address of one interface in a router; DFM discovers the rest of the interfaces. 
In the case of a switch, you need only provide the name or IP address of the 
switch’s SNMP agent. DFM automatically determines the switch’s configuration 
and how it connects to other devices listed in the DFM inventory.

The seed file must be stored on the host on which the domain manager runs. It is 
recommended that you store it under its default path name, 
NMSROOT\objects\smarts\conf\seedfile. 

Format of a Seed File
A seed file consists of lines with one or two columns. Separate the columns with 
any combination of spaces and tab characters. The first column names the 
network device. You can specify either a name or an IP address. You can intermix 
the two formats freely within a single seed file.

The second column defines the read community string. It is meaningful only if an 
SNMP agent is accessible at the default SNMP port (UDP port 161) at the name 
or address given in the first column. If you omit this column, DFM uses a default 
value; the initial default value is public. If many of your devices use a single 
alternative read community string, you can change DFM’s default (see the 
“Changing the Default Read Community String” section on page 3-11 for 
additional information). To make your seed file more readable, you can include 
blank and comment lines. A comment line is one that begins with a # sign. 
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The following offers a brief example of a seed file:

# Sample seed file
192.168.1.200
access-router-1 private
192.168.2.100 public
host1.example.com.

The default read community string (public, unless changed) is used for the devices 
at IP address 192.168.1.200 and at name host1.example.com, because an alternate 
string is not specified. The read community string for access-router-1 is private, 
and the read community string for 192.168.2.100 is public, regardless of the 
default community string.

How To Determine What to Put in a Seed File
The seed file must list all of the network devices that DFM is to manage. Creating 
the seed file can be a substantial task if it is done manually. However, the 
necessary information is usually available from existing computer-accessible 
sources. This section lists a variety of sources where this information might be 
found:

• If you are using CiscoWorks with Essentials on another host but do not want 
to use it to perform automatic updates, you can dump the hardware inventory 
to a text file. That text file can be converted into a seed file. Similar 
operations may be possible with other network management platforms.

• If you are using HP OpenView or NetView, you can obtain this information 
from the ovsnmp.conf file. This configuration file is maintained by the 
xnmsnmpconf configuration utility. By default, for example, the 
ovsnmp.conf is located in \usr\OV\conf.

• If you store backup router or switch configuration files at a central location, 
you can construct a seed file from them.

• Domain name resolution files, such as hosts.txt or zone files, are often a 
useful source. Note that, at sites with multiple administrative authorities who 
choose different read community strings, the hosts listed in a given zone file 
often share an administrative authority and hence a read community string.

TACACS configuration files may be useful for similar reasons.
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• Large sites usually maintain hardware inventories in a database or at least in 
some computer-readable form. These inventories often contain the necessary 
information.

• Some sites run network sniffer tools to keep track of active IP addresses. The 
lists of addresses they generate can form the basis for a seed file.

Choosing a Router Address for the Seed File: Special 
Considerations

As noted earlier, only a single name or IP address is necessary for a router. 
However, if a router is configured to allow SNMP access only on select interfaces, 
at least one of those interfaces must be listed in the seed file. While only one name 
or IP address is needed for a given network device, more than one can be listed. 
DFM automatically determines that the names or addresses actually belong to a 
single device. In complex network configurations, this capability enables DFM to 
reach the device using an alternate address if the primary address is inaccessible 
(due to a failure) during DFM’s initial probe of the device. (Once DFM has 
probed the device successfully, it knows all its IP addresses, and will 
automatically try them all to route around failures and reach the device.)

Accessing Device Fault Manager
To access DFM, select one of the following:

• Device Fault Manager >Monitoring Console to open the DFM Monitoring 
Console and check DFM polling and analysis results. For more information, 
refer to the User Guide for Device Fault Manager (available from online 
help).

• Device Fault Manager> Administration > Administration Console to open 
the Administration Console. For more information, refer to the “Opening the 
DFM Polling and Thresholds Console” section on page 3-12.

• From the Administration Console, select Edit > Polling and Thresholds to 
open the Polling and Thresholds Console to browse and fine tune the device 
inventory of your network. For more information, refer to the “Opening the 
DFM Polling and Thresholds Console” section on page 3-12.
3-10
Installation and Setup Guide for Device Fault Manager on Windows

78-14965-01



 

Chapter 3      Getting Started
Importing Devices from a Seed File
Importing Devices from a Seed File
When DFM is installed as a standalone product, a seed file—or a list of managed 
devices—must be imported into DFM to initiate inventory discovery.

To import a seed file:

Step 1 Select Device Fault Manager >Administration> Administration Console to 
open the Administration Console.

Step 2 Select Inventory > Import From Seed File or click on the Import From Seed File 
toolbar button. The Import From Seed File dialog box appears.

Step 3 Specify the complete path and the name of the seed file, and click OK. The 
Discovery Progress dialog box appears.

Note The seed file must be stored on the host where the domain manager runs.

When DFM imports devices from the seed file, it probes them to discover their 
configuration and adds their manageable elements to its inventory. For a large 
number of elements, this process may take several minutes.

Changing the Default Read Community String
DFM uses public as its default read community string to access the SNMP agents 
of managed devices. You can change the default read community string if the read 
community string for SNMP agents in your network is different.

Step 1 Click the domain manager icon.

Step 2 Select the Inventory tab in the right panel of the Administration Console.

Step 3 Specify a different read community string in the Default Read Community String 
field.

Step 4 Click Apply to make the new string take effect.
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Opening the DFM Administration Console
To open the Monitoring Console, select Device Fault Manager>
Administration >Administration Console.

The Administration Console displays an inventory tree that lists system classes 
and VLANs. Systems include devices such as switches, hubs, bridges, routers, 
router switch modules, probes, and hosts.

When an instance (managed element) of a class is selected in the left panel, DFM 
displays the properties of the instance under three tabs:

• Attributes lists the attributes and their values for the selected instance.

Note If a line appears in place of an attribute value, the value is derived by 
polling an external device that is currently unavailable to the domain 
manager. 

• Events lists the events that can occur in or affect the instance. Active events 
are colored according to their type. Double-clicking an event displays the 
Notification Properties dialog box for the event. For more information 
regarding the Notification Properties dialog box, see the User Guide for 
Device Fault Manager (available from the online help).

• Group lists the Polling and Threshold groups the instance is a member of and 
the settings from those groups that apply to the instance.

Opening the DFM Polling and Thresholds Console
From the Administration Console, select Edit > Polling and Thresholds to open 
the Polling and Thresholds Console.

The Polling and Thresholds Console enables you to display the settings and 
configurations of the managed devices. It also enables you to display the current 
device inventory.
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Settings are the polling parameters and notification thresholds that are applied to 
the managed devices of the network. Configuration groups, in turn, are collections 
of settings that are applied to specified groups of managed devices (hosts and 
routers, for example).

Step 1 Click the domain icon that is displayed in the left-hand panel of the window to 
display the configuration groups of the domain.

Step 2 Select and click on a configuration group to display the settings of that group. At 
this point, you can also display the description, priorities, and matching criteria 
for the group.

Step 3 Review the default information for the domain groups.

For additional information on the Polling and Thresholds Console, see the User 
Guide for Device Fault Manager (available from online help).

Checking Default Settings
When it is installed, DFM includes default values for all of the configurations and 
settings used by the application. The default values, however, can be modified to 
meet the requirements of your environment. For additional information about 
modifying the configurations and settings, see the User Guide for Device Fault 
Manager (available from online help).

Accessing the Device Inventory
To access the device inventory of your network, click the domain manager icon 
displayed in the left panel of the Administration Console to expand the inventory 
tree.

This inventory tree view enables you to traverse the device inventory that DFM 
imported from the Essentials database. The view displays the domain manager, its 
classes, a selected managed element (instance), and that element’s relationships 
to other elements.
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For each object you select in the inventory view, a corresponding property sheet 
appears. The property sheet displays the current value of the element’s attributes, 
its events (highlighting the active ones), and its configuration settings.

In the inventory view:

• Click the plus sign to expand individual objects.

• Click the plus sign next to the domain manager to view the classes (types) of 
elements it manages.

• Click the plus sign next to a class to view its instances. 

• Click an instance to view its properties. 

• Click the plus sign next to an instance to view its relations. 

• Click the plus sign next to a relation to view the classes of the related objects.

• Click the plus sign next to each class to view the actual related instances.

• Double-click an instance to create a new, separate window that displays an 
inventory browser starting with the selected object. 

For more information on viewing analysis results and other operator tasks, consult 
the User Guide for Device Fault Manager (available from online help).

Probing the DFM Inventory
After Device Fault Manager is installed, the DFM inventory is regularly probed. 
These topics provide information on how this is done:

• Synchronizing the DFM Inventory with the Essentials Inventory, page 3-14

• Rediscovering Devices in the Entire DFM Inventory, page 3-15

Synchronizing the DFM Inventory with the Essentials Inventory
When Essentials is installed, DFM (specifically, the DfmChangeProbe process) 
automatically queries the Essentials database, and sends device information to the 
DFM repository. DFM then probes the devices to analyze their properties and 
status.
3-14
Installation and Setup Guide for Device Fault Manager on Windows

78-14965-01



 

Chapter 3      Getting Started
Probing the DFM Inventory
During normal operation, the DfmChangeProbe process monitors messages that 
are broadcast by the Essentials inventory collector, and forwards inventory 
additions and updates to the DFM repository.

To check the status of the DfmChangeProbe process, when necessary, select 
Server Configuration >Administration > Process Management >Process 
Status.

To disable (or enable) the DfmChangeProbe process, select Device Fault 
Manager> Administration >Device Discovery > ChangeProbe. For more 
information, see the User Guide for Device Fault Manager (available from online 
help).

Note If you delete a device from the DFM inventory, the device is not deleted from the 
Essentials database. Therefore, when the DfmChangeProbe process again 
performs a query of the full Essentials database (after a restart of the system, for 
example), the deleted device is again added to the DFM repository.

Rediscovering Devices in the Entire DFM Inventory
In addition to the initial inventory probe, DFM includes a scheduled probe of the 
entire inventory. The scheduled probe is a batch process that is controlled by 
CiscoWorks. By default, the probe of the entire inventory is scheduled to run once 
a week, on Saturday night or Sunday morning. After the probe of the entire 
inventory, the DFM inventory is also synchronized with the Essentials inventory, 
and DFM is directed to rediscover the managed devices.

To check the status of a scheduled probe of the inventory, when necessary, select 
Server Configuration >Administration > Job Management.

To change the date, time, and duration of inventory collection, use the 
Rediscovery Schedule option:

Step 1 Select Administration > Device Discovery > Rediscovery Schedule.

Step 2 Enter the desired start date, time, and frequency, and click OK.
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If the Rediscovery Schedule job is stopped by the CiscoWorks Job Manager, you 
must remove the job and then schedule discovery again. 

To remove the job:

Step 1 Select CiscoWorks Server> Administration> Job Management.

Step 2 Select the job and click Remove Job.

For more information on rediscovering devices in the DFM inventory, refer to the 
User Guide for Device Fault Manager (available from online help).

Opening the DFM Monitoring Console
To open the Monitoring Console, select Device Fault Manager> Monitoring 
Console.

The Monitoring Console displays the results of DFM’s polling and analysis of the 
managed devices. The Console automatically receives and displays notifications 
in the Alarm Log view.

Note When you open a Monitoring Console using the CiscoWorks navigation tree, by 
default the Monitoring Console does not display the Inventory Browser. If you 
want to open a Monitoring Console that displays the Inventory Browser, either 
(1) open a Monitoring Console using the Administration Console’s toolbar 
button, or (2) open a Monitoring Console from any running console in a session 
using File >New> Monitoring Console.

As exceptional conditions occur across the network, notifications begin to appear 
in the Alarm Log view of the Monitoring Console. In the Alarm Log view, 
information presented for the notifications includes class (or type) of managed 
element, name of managed element, name of notified event, certainty of 
diagnosis, number of times the event occurred, last change (of state), first 
notification (the time the event was first detected), and the name of the domain 
manager.

To view possible causes or events used in the analysis, double-click the 
notification in the Alarm Log. This displays the Notification Properties window.
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The Notification Properties window displays the selected event notification, the 
name of the device associated with the notification, the general properties of that 
device, and any associated component notifications. Thus, it provides you with 
the information that you need to resolve the problem.

For additional information on the Monitoring Console, see the User Guide for 
Device Fault Manager (available from online help).

Closing the DFM Monitoring Console
Three methods exist to close the Monitoring Console (none affect the domain 
manager):

• Select File> Close. 

The Close command closes an individual Console and the session continues. 
When you close the last Monitoring Console, you end the DFM session. 

• Select File> Exit.

The Exit command closes all consoles that are part of the session, and the 
session ends. 

• Close your Web browser.

Note When you log out of CiscoWorks, the Monitoring Console remains displayed for 
continuous viewing. To close the Console, you must explicitly close it or the Web 
browser.
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